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1
Product Description

The HP Pavilion dv1600 Entertainment Notebook PC offers 
advanced modularity, Intel® Core™ Duo, Core Solo, and 
Celeron® M processors, and extensive multimedia support.

HP Pavilion dv1600 Entertainment Notebook PC
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Product Description
1.1 Features
■ The following processors are available, varying by 

computer model:

❏ Intel Core Duo T2500 (2.00-GHz)

❏ Intel Core Duo T2400 (1.83-GHz

❏ Intel Core Duo T2300E (1.66-GHz)

❏ Intel Core Duo T2250 (1.73-GHz)

❏ Intel Core Duo T2300 (1.66-GHz)

❏ Intel Core Duo T2050 (1.60-GHz)

❏ Intel Core Solo T1350 (1.86-GHz)

❏ Intel Core Solo T1300 (1.66-GHz)

❏ Intel Celeron M 410 (1.46-GHz)

■ 14.0-inch WXGA (1280 × 768) TFT display with over 
16.7 million colors, varying by computer model

■ 100-, 80-, 60-, or 40-GB high-capacity hard drive, varying 
by computer model

■ 256-MB DDR synchronous DRAM (SDRAM) at 667 MHz 
and 533 MHz, expandable to 2.0 GB on computer models 
with Intel Core Duo processors and 1.0 GB on computer 
models with Intel Celeron M and Intel Core Solo processors

■ Microsoft® Windows® XP Home Edition or Windows XP 
Professional, or Free DOS, varying by computer model

■ Full-size Windows keyboard with embedded numeric keypad

■ TouchPad pointing device with on/off button and dedicated 
two-way scroll region

■ Integrated 10/100 BASE-T Ethernet local area network 
(LAN) network interface card (NIC) with RJ-45 jack

■ Integrated high-speed 56K modem with RJ-11 jack

■ Integrated wireless support for Mini Card IEEE 802.11b and 
802.11b/g WLAN device
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Product Description
■ Support for one ExpressCard

■ External 65-watt AC adapter with 3-wire power cord

■ 6-cell or 12-cell Li-Ion battery

■ Stereo speakers with volume up and down buttons

■ Integrated Web camera

■ Integrated microphone

■ Support for the following optical drives:

❏ 8X Max DVD+RW/R and CD-RW Combo Drive

❏ 4X Max DVD+RW/R and CD-RW Combo Drive

❏ 8X Max DVD-ROM Drive

❏ 24X Max DVD/CD-RW Combo Drive

■ Connectors:

❏ Audio-in (microphone)

❏ Audio-out (headphone)

❏ Digital Media Slot (select computer models only)

❏ Docking (select computer models only)

❏ ExpressCard

❏ External monitor

❏ IEEE 1394 digital (select computer models only)

❏ Infrared

❏ Power

❏ RJ-11 (modem)

❏ RJ-45 (network)

❏ S-Video-out (select computer models only)

❏ Universal Serial Bus (USB) v. 2.0
Maintenance and Service Guide 1–3



Product Description
1.2 Resetting the Computer
If the computer you are servicing has an unknown password, 
follow these steps to clear the password. These steps also 
clear CMOS:

1. Prepare the computer for disassembly (refer to Section 5.3, 
“Preparing the Computer for Disassembly,” for more 
information).

2. Remove the real-time clock (RTC) battery (refer to
Section 5.16, “RTC Battery,” for more information).

3. Wait approximately 5 minutes.

4. Replace the RTC battery and reassemble the computer.

5. Connect AC power to the computer. Do not reinsert any 
batteries at this time.

6. Turn on the computer.

All passwords and all CMOS settings have been cleared.
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Product Description
1.3 Power Management
The computer comes with power management features that 
extend battery operating time and conserve power. The 
computer supports the following power management features:

■ Standby

■ Hibernation

■ Setting customization by the user

■ Hotkeys for setting the level of performance

■ Battery calibration

■ Lid switch standby/resume

■ Power/standby button

■ Advanced Configuration and Power Management (ACPM) 
compliance
Maintenance and Service Guide 1–5



Product Description
1.4 External Components
The external components on the front of the computer are shown 
below and described in Table 1-1.

Front Components
1–6 Maintenance and Service Guide
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Table 1-1

Front Components

Item Component Function

1 Speakers (2) Produce stereo sound.

2 Power light ■ On: Computer is turned on.

■ Blinking: Computer is in standby.

■ Off: Computer is off.

3 Drive light On or blinking: The internal hard drive or an 
optical drive is being accessed.

4 Battery light ■ Amber: The battery is charging.

■ Green: The battery is fully charged.

■ Off: The battery is discharging or not 
inserted.

5 Display release latch Opens the computer.

6 Audio-in 
(microphone) jack

Connects an optional monaural (single 
sound channel) microphone.

7 Audio-out 
(headphone) jack (2)

Connect optional headphones or powered 
stereo speakers. Also connect the audio 
function of an audio/video device such as 
a television or VCR.
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The external components on the right side of the computer are 
shown below and described in Table 1-2.

Right-Side Components
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Table 1-2

Right-Side Components

Item Component Function

1 USB connectors (2) Connect an optional USB device.

2 Digital Media Slot 
(select computer 
models only)

In Windows, supports digital cards.

3 1394 port
(select computer 
models only)

Connects an optional 1394a device such 
as a scanner, digital camera, or digital 
camcorder.

4 Digital Media
Slot light
(select computer 
models only)

On: A digital card is being accessed.

5 Optical drive Supports an optical disc.

6 S-Video-out jack 
(select computer 
models only)

Connects an optional S-Video device, such 
as a television, VCR, camcorder, projector, 
or video capture card.
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The external components on the rear and left side of the computer 
are shown below and described in Table 1-3.

Rear and Left-Side Components
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Table 1-3

Rear and Left-Side Components

Item Component Function

1 Wireless light
(select computer 
models only)

On: An internal wireless device, such as 
a wireless LAN device and/or a Bluetooth 
device, is turned on.

✎ To establish a wireless connection, a 
wireless network must already be set 
up.

2 Exhaust vent Provides airflow to cool internal 
components.

Ä To prevent overheating, do not 
obstruct vents. Do not allow a hard 
surface, such as a printer, or a soft 
surface, such as pillows, thick rugs 
or clothing, to block airflow.

3 Power connector Connects an AC adapter cable.

4 External monitor port Connects an optional VGA external monitor 
or projector.

5 Expansion port 2 Connects the computer to an optional 
expansion product or docking device.

6 RJ-45 (network) jack Connects an optional network cable.

7 RJ-11 (modem) jack Connects the modem cable.

8 USB connector Connects an optional USB device.

9 ExpressCard slot Supports an optional ExpressCard.

10 Security cable slot Attaches an optional security cable to the 
computer.
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The keyboard components on the computer are shown below and 
described in Table 1-4.

Keyboard Components
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Table 1-4

Keyboard Components

Item Component Function

1 fn key Combines with other keys to perform 
system tasks. For example, pressing 
fn+f7 decreases screen brightness.

2 caps lock key Enables caps lock and turns on the 
caps lock light.

3 f1 to f12 keys (12) Perform system and application tasks. 
When combined with the fn key, several 
keys and buttons perform additional tasks 
as hotkeys.

4 num lock key Enables numeric lock, turns on the 
embedded numeric keypad, and turns 
on the num lock light.

5 Keypad keys (15) In Windows, can be used like the keys 
on an external numeric keypad.

6 Arrow keys Move the cursor around the screen.

7 Windows 
applications key

In Windows, displays a shortcut menu 
for items beneath the pointer.

8 Windows logo key In Windows, displays the Windows 
Start menu.
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The top components on the computer are shown below and 
described in Table 1-5.

Top Components, Part 1

Table 1-5

Top Components, Part 1

Item Component Function

1 Display switch If the computer is closed while on, turns off 
the display.

2 Power button When the computer is

■ Off, press to turn on the computer.

■ On, briefly press to initiate Hibernation.

■ In Standby, briefly press to resume 
from Standby.

■ In Hibernation, briefly press to restore 
from Hibernation.
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3 DVD button When the computer is

■ Off, opens QuickPlay DVD mode.

■ On in Windows, opens the default 
Windows DVD application.

■ On in QuickPlay music mode, opens 
QuickPlay DVD mode.

■ On in QuickPlay DVD mode, displays 
the DVD setup menu.

■ In Standby, resumes from Standby 
into Windows.

■ In Hibernation, opens QuickPlay 
DVD mode.

4 Media button When the computer is

■ Off, opens QuickPlay music mode.

■ On in Windows, opens the default 
Windows music application.

■ On in QuickPlay DVD mode, opens 
QuickPlay music mode.

■ In Standby, resumes from Standby 
into Windows.

■ In Hibernation, opens QuickPlay 
music mode.

5 Previous/Rewind 
Button

When a disc is in the optical drive:

■ Press to play the previous track or 
chapter.

■ Press fn+this button to rewind.

6 Play/Pause button When a disc is in the optical drive and is:

■ Not playing, press to play the disc.

■ Playing, press to pause the disc.

Table 1-5

Top Components, Part 1 (Continued)

Item Component Function
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The top components on the computer are shown below and 
described in Table 1-6.

Top Components, Part 2
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Table 1-6

Top Components, Part 2

Item Component Function

1 Next/Fast Forward 
button

When a disc is in the optical drive:

■ Press once to play the next track or 
chapter.

■ Press fn+this button to fast forward.

2 Stop button When a disc is in the optical drive, press 
to stop the current disc activity. 

3 Volume down button Decreases system volume.

4 Volume mute button
Mute light

Mutes or restores volume.
On: Volume is muted.

5 Volume up button Increases system volume.

6 Wireless button Enables/disables an internal wireless 
device.
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The top components on the computer are shown below and 
described in Table 1-7.

Top Components, Part 3
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Table 1-7

Top Components, Part 3

Item Component Function

1 TouchPad Moves the pointer.

2 TouchPad light On: TouchPad is enabled.

3 Caps lock light On: Caps lock is on.

4 Power/ button light ■ On: Computer is turned on.

■ Blinking: Computer is in standby.

■ Off: Computer is off.

5 Wireless light On: An internal wireless device, such as 
a wireless LAN device and/or a Bluetooth 
device, is turned on.

✎ To establish a wireless connection, a 
wireless network must already be set 
up.

6 Num lock light On: Num lock or the internal keypad is on.

7 Back button ■ In Windows, emulates the “back” function 
of the alt+left arrow command in the 
active application.

■ In QuickPlay, moves up one directory 
level in an on-screen menu.

8 OK button Selects an item you have chosen on the 
screen.

9 TouchPad on/off 
button

Enables/disables the TouchPad.

10 TouchPad vertical 
scroll region

Scrolls upward or downward.

11 Left and right 
TouchPad buttons

Function like the left and right buttons on an 
external mouse.
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The external components on the bottom of the computer are 
shown below and described in Table 1-8.

Bottom Components

Table 1-8

Bottom Components

Item Component Function

1 Optical drive Supports an optical disc.

2 Battery release latch Releases a battery from the battery bay.

3 Battery bay Holds a battery 
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4 Exhaust vents (4) Provide airflow to cool internal 
components.

Ä To prevent overheating, do not 
obstruct vents. Use the computer 
only on a flat, hard surface. Do 
not allow a hard surface, such as 
a printer, or a soft surface, such 
as pillows, thick rugs or clothing, 
to block airflow.

5 Hard drive bay Holds the internal hard drive.

6 Mini Card compartment Holds an optional Mini Card device.

Ä To prevent an unresponsive 
system and the display of a 
warning message, install only a 
Mini Card device authorized for 
use in your computer by the 
governmental agency that 
regulates wireless devices in your 
country. If you install a device and 
then receive a warning message, 
remove the device to restore 
computer functionality. Then 
contact Customer Care.

7 Memory module 
compartment

Contains 2 memory slots that support 
replaceable memory modules. The 
number of preinstalled memory 
modules varies by computer model.

8 Label areas (2) Contain the computer serial number 
and other applicable regulatory labels.

Table 1-8

Bottom Components (Continued)

Item Component Function
Maintenance and Service Guide 1–21



Product Description
1.5 Design Overview
This section presents a design overview of key parts and features 
of the computer. Refer to Chapter 3, “Illustrated Parts Catalog,” 
to identify replacement parts, and Chapter 5, “Removal and 
Replacement Procedures,” for disassembly steps.

The system board provides the following device connections:

■ Audio

■ Display

■ Fan

■ Hard drive

■ Intel Celeron M and Intel Core Duo and Core Solo processors

■ Keyboard and TouchPad

■ Memory module

■ Mini Card modules

■ PC Card

Ä
CAUTION: To properly ventilate the computer, allow at least a 7.6-cm 
(3-inch) clearance on the left and right sides of the computer.

The computer uses an electric fan for ventilation. The fan is 
controlled by a temperature sensor and is designed to turn on 
automatically when high temperature conditions exist. These 
conditions are affected by high external temperatures, system 
power consumption, power management/battery conservation 
configurations, battery fast charging, and software. Exhaust air is 
displaced through the ventilation grill located on the left side of 
the computer.
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2
Troubleshooting

Å
WARNING: Only authorized technicians trained by HP should repair 
this equipment. All troubleshooting and repair procedures are detailed 
to allow only subassembly-/module-level repair. Because of the 
complexity of the individual boards and subassemblies, do not attempt 
to make repairs at the component level or modifications to any printed 
wiring board. Improper repairs can create a safety hazard. Any 
indication of component replacement or printed wiring board 
modification may void any warranty or exchange allowances.

2.1 Computer Setup
Computer Setup is a system information and customization utility 
that can be used even when the operating system is not working 
or will not load. This utility includes settings that are not 
available in Windows.

Using Computer Setup

Information and settings in Computer Setup are accessed from 
the File, Security, Diagnostics, or System Configuration menus:

1. Turn on or restart the computer. Press f10 while the 
F10 = ROM-Based Setup message is displayed in 
the lower-left corner of the screen.

❏ To change the language, use the cursor control keys 
to navigate to the System Configuration menu.

❏ To view navigation information, press f1.

❏ To return to the Computer Setup menu, press esc.
Maintenance and Service Guide 2–1
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2. Select the File, Security, Diagnostics, or 
System Configuration menu.

3. To close Computer Setup and restart the computer:

❏ Select File > Save changes and exit, and then press enter.

– or –

❏ Select File > Ignore changes and exit, and then 
press enter.

– or –

❏ Select File > Restore defaults, and then press enter.

4. When you are prompted to confirm your action, press f10.

Selecting from the File Menu

Table 2-1

File Menu

Select To Do This

System Information ■ View identification information about the 
computer, processor, memory and cache size, 
and system ROM.

■ View BIOS revision, keyboard controller 
version, and battery serial number information.
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Selecting from the Security Menu

Table 2-2

Security Menu

Select To Do This

Setup Password Enter, change, or delete an Setup password.

Power-On Password Enter, change, or delete a power-on password.

Password Options
(Password options can 
be selected only when 
a power-on password 
has been set.)

Enable/disable

■ Stringent security.

■ Requirement of password on restart.

DriveLock Passwords Enable/disable DriveLock; change a DriveLock 
user or master password.

✎ DriveLock Settings are accessible only 
when you enter Computer Setup by turning 
on (not restarting) the computer.

Smart Card Security Enable/disable smart card power-on support.

✎ A setup password must be established to 
use this feature.

TPM Embedded Security Enable/disable

■ Embedded security device state.

■ Power-on authentication support.

■ Automatic DriveLock support.

System IDs Establish

■ Notebook asset tracking number.

■ Notebook ownership tags.

Disk Sanitizer Establish fast, optimum, or custom settings for 
disk sanitizing.

*Not applicable to SuperDisk LS-120 drives.
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Selecting from the Diagnostics Menu

Table 2-3

Diagnostics Menu

Select To Do This

HDD Self-Test Options Run a quick comprehensive self test on hard 
drives in the system that support the test features.

Memory Check Run a quick comprehensive test on system 
memory on the following categories:

■ Walking 0s

■ Walking 1s

■ High Address line testing

■ Alternate Pattern testing
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Selecting from the System 
Configuration Menu

Table 2-4

System Configuration Menu

Select To Do This

Language Change the Computer Setup language.

Boot Options Enable/disable MultiBoot, which sets a startup 
sequence that can include most bootable devices 
and media in the system.

Device Configurations Enable/disable

■ Swap Fn/Ctrl keys.

■ USB legacy support.

■ BIOS DMA data transfers.

■ Fan Always on while on AC Power.

■ Data Execution Prevention.

■ LAN Power save.

Built-In Device Options Enable/disable

■ Embedded WLAN Device Radio.

■ Embedded Bluetooth Device Radio.

■ LAN/WLAN Switching.

■ Wake on LAN from Off.

Port Options Enable/disable

■ USB Port.

■ 1394 Port.

■ CardBus Slot.
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2.2 Troubleshooting Flowcharts

Table 2-5

Troubleshooting Flowcharts Overview

Flowchart Description

2.1 “Flowchart 2.1—Initial Troubleshooting”

2.2 “Flowchart 2.2—No Power, Part 1”

2.3 “Flowchart 2.3—No Power, Part 2”

2.4 “Flowchart 2.4—No Power, Part 3”

2.5 “Flowchart 2.5—No Power, Part 4”

2.6 “Flowchart 2.6—No Video, Part 1”

2.7 “Flowchart 2.7—No Video, Part 2”

2.8 “Flowchart 2.8—Nonfunctioning Docking Device (if applicable)”

2.9 “Flowchart 2.9—No Operating System (OS) Loading”

2.10 “Flowchart 2.10—No OS Loading, Hard Drive, Part 1”

2.11 “Flowchart 2.11—No OS Loading, Hard Drive, Part 2”

2.12 “Flowchart 2.12—No OS Loading, Hard Drive, Part 3”

2.13 “Flowchart 2.13—No OS Loading, Diskette Drive”

2.14 “Flowchart 2.14—No OS Loading, Optical Drive”

2.15 “Flowchart 2.15—No Audio, Part 1”

2.16 “Flowchart 2.16—No Audio, Part 2”

2.17 “Flowchart 2.17—Nonfunctioning Device”

2.18 “Flowchart 2.18—Nonfunctioning Keyboard”

2.19 “Flowchart 2.19—Nonfunctioning Pointing Device”

2.20 “Flowchart 2.20—No Network/Modem Connection”
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Flowchart 2.1—Initial Troubleshooting
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LED board,

speaker
connections.

Go to
“Flowchart 
2.20—No 

Network/Modem 
Connection.”
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Troubleshooting
Flowchart 2.2—No Power, Part 1

1. Reset the power cables in the docking device 
and at the AC outlet.

2. Be sure the AC power source is active.
3. Be sure that the power strip is working.

Done

Remove from
docking device
(if applicable).

Power up
on battery

power?

Power up
on AC

power?

Power up in 
docking 
device?

Power up
on battery

power?

Power up
in docking 

device?

Done

Reset
 power.*

Reset
 power.*

Power up
on AC power?

N

Y

Y

N

N

Y

N

N

Y

Y

Y N

1. On select computer models, there is a 
separate reset button.

2. On select computer models, the computer 
can be reset using the standby switch and 
either the lid switch or the main power 
switch.

*NOTES

Go to
“Flowchart 

2.4—No Power, 
Part 3.”

Go to
“Flowchart 

2.3—No Power, 
Part 2.”

Go to
“Flowchart 

2.8—Nonfunctioning 
Docking Device 
(if applicable).”

No power 
(power LED

is off).
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Troubleshooting
Flowchart 2.3—No Power, Part 2

Continued from
“Flowchart 

2.2—No Power, 
Part 1.”

Visually check for
debris in battery
socket and clean

if necessary.

Done

N

Y

Power on?

Check battery by
recharging it,
moving it to

another computer,
or replacing it.

Power on?

Done

Y

Replace
power supply
(if applicable).

N

Power on?

Done

Y

N
Go to

“Flowchart 
2.4—No Power, 

Part 3.”
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Troubleshooting
Flowchart 2.4—No Power, Part 3

Continued from
“Flowchart 

2.3—No Power, 
Part 2.”

Reseat AC adapter
in computer and
at power source.

Internal or
external AC
adapter?

Done

Done

Done
Done

Power on?

Power on?

Power on?

Plug directly
into AC outlet.

Power LED
on?

Power outlet
active?

Try different
outlet.

Replace external
AC adapter.

Replace
power cord.

Y

N

Y

Y

Y

Y

N

N

N

N

External

Internal

Go to
“Flowchart 

2.5—No Power, 
Part 4.”
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Troubleshooting
Flowchart 2.5—No Power, Part 4

Y

N

Continued from
“Flowchart 

2.4—No Power, 
Part 3.”

Reseat loose
components and

boards and 
replace damaged 

items.

Open
computer.

Loose or
damaged

parts?

Y

Close
computer and

retest.

Power on?

Done

N
Replace the following items (if applicable). Check 
computer operation after each replacement:
1. Internal DC-DC converter*
2. Internal AC adapter
3. Processor board*
4. System board*

*NOTE: Replace these items as a set to prevent 
shorting out among components.
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Troubleshooting
Flowchart 2.6—No Video, Part 1

A

N

Stand-alone
or docking 

device?

No video.

Replace the following one at a time. Test after each replacement.
1. Cable between computer and computer display (if applicable)
2. Display
3. System board

Internal or
external
display*?

Adjust
brightness. Video OK? Done

Docking Device

Internal

Stand-alone

External

Adjust
brightness.

Video OK? Done

Y

Press lid
switch to ensure

operation.

Video OK? Done

Y

N

Video OK?

Done Done

N

Check for bent
pins on cable.

Try
another
display.

Internal and
external

video OK?

Replace
system
board.

Y Y

NN

*NOTE: To change from internal to 
external display, use the hotkey 
combination.

Y

Go to
“Flowchart 

2.7—No Video, 
Part 2.”
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Troubleshooting
Flowchart 2.7—No Video, Part 2

Y

N

Continued from
“Flowchart 

2.6—No Video, 
Part 1.”

Done

Adjust external
monitor display.

Video OK?

Adjust
display

brightness.

Video OK?

Video OK?

Done

Done

Check that computer is properly
seated in docking device, for 
bent pins on cable, and for

monitor connection.

Go to “A” in
“Flowchart 

2.6—No Video, 
Part 1.”

Check brightness
of external
monitor.

Try another
external
monitor.

Internal
and external
video OK?

Go to
“Flowchart 

2.8—Nonfunctioning 
Docking Device 
(if applicable).”

Y

Y

Y

N

N

N

Remove 
computer from 
docking device, 

if connected.
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Troubleshooting
Flowchart 2.8—Nonfunctioning Docking Device
(if applicable)

Y

N

Reset power cord in 
docking device and

power outlet.

N

Test replacement 
docking device with 

new computer.

Check voltage
setting on docking 

device.

Reset monitor
cable connector at

docking device.

Reinstall
computer into 

docking device.

Docking 
device

operating?

Docking 
device

operating?

Replace docking 
device.

Done Done

Y

Nonfunctioning
docking device.
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Troubleshooting
Flowchart 2.9—No Operating System (OS) 
Loading

No OS loading from hard drive,
go to “Flowchart 2.10—No OS Loading, 

Hard Drive, Part 1.”

Reset power
cord in docking 

device and
power outlet.

No OS
loading.*

*NOTE: Before beginning troubleshooting, always 
check cable connections, cable ends, and drives 
for bent or damaged pins.

No OS loading from diskette drive,
go to “Flowchart 2.13—No OS Loading, 

Diskette Drive.”

No OS loading from CD-ROM or DVD-ROM 
drive, go to “Flowchart 2.14—No OS 

Loading, Optical Drive.”

No OS loading from network,
go to “Flowchart 2.20—No Network/Modem 

Connection.”
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Troubleshooting
Flowchart 2.10—No OS Loading, Hard Drive, 
Part 1

Go to
“Flowchart 

2.17—Nonfunctioning 
Device.”

Y

Done

N

OS not
loading from
hard drive.

Nonsystem
disk message?

Go to
“Flowchart 

2.11—No OS 
Loading, 

Hard Drive, Part 2.”

Reseat
external

hard drive.

OS loading? Done

Boot
from
CD?

Go to
“Flowchart 

2.13—No OS 
Loading, 

Diskette Drive.”

Boot
from

hard drive?

Boot
from

diskette?

Change boot
priority through
the Setup Utility

and reboot.

Boot
from

hard drive?

Y

Y

Y

Y

Y

N

N

N

N

N

Check the Setup
utility for correct

booting order.
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Troubleshooting
Flowchart 2.11—No OS Loading, Hard Drive, 
Part 2

Load OS using 
Operating System 
disc (if applicable).

Continued from
“Flowchart 

2.10—No OS 
Loading, 

Hard Drive, Part 1.”
Reseat

hard drive.

Done

CD or
diskette in

drive?

1. Replace 
hard drive.

2. Replace system 
board.

Go to
“Flowchart 

2.13—No OS 
Loading, 

Diskette Drive.”

Format hard drive
and bring to
a bootable
C:\ prompt.

Create partition, 
and then format 

hard drive to 
bootable

C:\ prompt.

Boot
from diskette

drive?

Remove
diskette and

reboot.

Y

N

Boot
from

hard drive?

Y

N

Y

N

Hard drive 
accessible?

Y

N

Hard drive
accessible?

Done

Run FDISK.

Y

N

Hard drive
partitioned?

Hard drive
formatted?

Y

N

Y

N

Computer
booted?

Done

Y

N
Go to

“Flowchart 
2.12—No OS 

Loading, 
Hard Drive, Part 3.”

Go to
“Flowchart 

2.12—No OS 
Loading, 

Hard Drive, Part 3.”
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Troubleshooting
Flowchart 2.12—No OS Loading, Hard Drive, 
Part 3

Y

System
files on hard

drive?

Continued from
“Flowchart 

2.11—No OS 
Loading, 

Hard Drive, Part 2.”

Clean virus. Done

N

Install OS
and reboot.

Virus
on 

hard drive?

OS
loading from
hard drive?

Y

N

Y

N

Y

N

Diagnostics
on diskette?

Replace
hard drive.

Run diagnostics
and follow

recommendations.

Run SCANDISK and 
check for

bad sectors.

Can bad
sectors

be fixed?

Replace
hard drive.

Y

N

Y

N

Fix bad
sectors.

Boot from
hard drive?

Replace
hard drive.

Done
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Troubleshooting
Flowchart 2.13—No OS Loading, Diskette Drive

Done

Y

N

Reseat
diskette drive.

OS not loading
from

diskette drive.

Done

Y

Y

YY

Y Y

YN

N

N

N

N

N

N

OS
loading?

Nonsystem
disk message?

Bootable
diskette
in drive?

Install bootable
diskette and

reboot computer.

Check diskette
for system files.

Try different
diskette.

1. Replace diskette 
drive.

2. Replace system 
board.

Nonsystem
disk error?

OS
loading?

Boot
from another

device?

Enable drive
and cold boot

computer.

Is diskette
drive boot

order 
correct?

Change boot
priority using

the Setup Utility.

Go to
“Flowchart 

2.17—Nonfunc-
tioning Device.”

Diskette
drive enabled
in the Setup

Utility?

Go to
“Flowchart 

2.17—Nonfunctioning 
Device.”

Reset the computer. 
Refer to

Section 1.2, 
“Resetting the 
Computer,” for 

instructions.
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Troubleshooting
Flowchart 2.14—No OS Loading, Optical Drive

Y

Done

N

Bootable
disc in
drive?

Disc
in drive?

No OS
loading from
CD-ROM or

DVD-ROM drive.

Install bootable
disc and
reboot

computer.

Go to
“Flowchart 

2.17—Nonfunctioning 
Device.”

Go to
“Flowchart 

2.17—Nonfunctioning 
Device.”

Install
bootable disc.

Boots from
CD or DVD?

Boots from
CD or DVD?

Try another
bootable disc.

Booting
from another

device?

Booting
order

correct?

Correct boot
order using

the Setup Utility.

DoneReseat
drive.

Y

Y

Y

Y

Y

N

N

N

N

N

Reset the computer. 
Refer to

Section 1.2, 
“Resetting the 
Computer,” for

instructions.
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Troubleshooting
Flowchart 2.15—No Audio, Part 1

No audio.

N

Computer in
docking device
(if applicable)?

Internal
audio?

Audio? Done

Undock

Audio? Done

Turn up audio
internally or
externally.

Go to
“Flowchart 

2.16—No Audio, 
Part 2.”

Go to
“Flowchart 

2.17—Nonfunctioning 
Device.”

Y

Y

Y

Y

N

N

N

Go to
“Flowchart 

2.16—No Audio, 
Part 2.”

Replace
the

docking device.
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Troubleshooting
Flowchart 2.16—No Audio, Part 2

Y N

Continued from 
“Flowchart 

2.15—No Audio, 
Part 1.”

Reload
audio drivers.

Audio
driver in OS
configured?

Audio?

Y

Y

YN

N

N

Correct
drivers for

application?

Connect to
external
speaker.

Load drivers and
set configuration

in OS.

Audio? Done

Replace audio
board and
speaker

connections
in computer 

(if applicable).

1. Replace internal speakers.
2. Replace audio board (if applicable).
3. Replace system board.
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Troubleshooting
Flowchart 2.17—Nonfunctioning Device

Done

Any physical
device detected?

Y

N

Unplug the nonfunctioning device from the computer 
and inspect cables and plugs for bent or broken pins or 

other damage.

Reseat 
device.

Clear
CMOS.

Done

Fix or
replace

broken item.

Nonfunctioning
device.

Reattach device.
Close computer,
plug in power,

and reboot.

Device
boots

properly?

Go to
“Flowchart 
2.9—No 

Operating System 
(OS) Loading.”

Device
boots

properly?

Replace hard drive.

Replace diskette 
drive.

Replace NIC.
If integrated NIC,
replace system 

board.
Y

N

Y

N
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Troubleshooting
Flowchart 2.18—Nonfunctioning Keyboard

Y

N

OK?

Keyboard
not operating 

properly.

External
device
works?

Replace
system
board.

Replace
system
board.

Connect computer
to good external 

keyboard.

Reseat internal 
keyboard
connector

(if applicable).

Replace internal
keyboard or

cable.

OK?

Y

N

Y

N

Done Done
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Troubleshooting
Flowchart 2.19—Nonfunctioning Pointing 
Device

Y

N

OK?

Pointing device
not operating

properly.

External
device
works?

Replace
system
board.

Replace
system
board.

Connect computer
to good external
pointing device.

Reseat internal
pointing device

connector 
(if applicable).

Replace internal
pointing device 

or cable.

OK?

Y

N

Y

N

Done Done
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Troubleshooting
Flowchart 2.20—No Network/Modem 
Connection

Y

Disconnect all
power from

the computer
and open.

No network
or modem 

connection.

N

Done

Digital
line?

Network
or modem jack 

active?

Replace jack 
or have jack 
activated.

Connect
to nondigital

line.

NIC/modem 
configured 

in OS?

Reload
drivers and 
reconfigure.

Reseat NIC/modem
(if applicable).

Replace the 
NIC/modem

(if applicable).

Replace
system
board.

OK?

OK? Done

N

N

N

N

Y

Y

Y

Y
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3
Illustrated Parts Catalog

This chapter provides an illustrated parts breakdown and a 
reference for spare part numbers and option part numbers.

3.1 Serial Number Location
When ordering parts or requesting information, provide the 
computer serial number and computer model number located on 
the bottom of the computer.

Serial Number Location
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Illustrated Parts Catalog
3.2 Computer Major Components

Computer Major Components
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components

Item Description
Spare Part 
Number

1 Display assemblies (include wireless antenna transceivers 
and cables)

With Web camera
14.0-inch, WXGA, SVA with BrightView
14.0-inch, WXGA

431091-001
431827-001

Without Web camera
14.0-inch, WXGA, SVA with BrightView
14.0-inch, WXGA

412338-001
412336-001

✎ Refer to Section 3.3, “Display Assembly Components,” for 
display assembly internal component spare part number 
information.

2 Switch covers (include wireless button and light)

For use on computer models with wireless capability
For use on computer models without wireless 
capability
For use on computer models with wireless capability 
sold at Best Buy

412391-001
412393-001

418238-001
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

3 Keyboards

Belgium
Brazil
Denmark
France
French Canada
Germany
Greece
Israel
International
Italy
Japan
Korea
Latin America
Norway
Portugal

412374-A41
412374-201
412374-081
412374-051
412374-121
412374-041
412374-DJ1
412374-BB1
412374-B31
412374-061
412374-291
412374-AD1
412374-161
412374-091
412374-131

Saudi Arabia
Spain
Switzerland
Taiwan
Thailand
The United 

Kingdom
Asia Pacific, 

Australia, 
Canada,
Hong Kong, 
the People’s 
Republic
of China, and 
the United 
States

412374-171
412374-071
412374-111
412374-AB1
412374-281
412374-031

412374-001

4 LED board (includes cable, not illustrated) 412399-001

5 Top covers (include TouchPad)

For use on computer models with Web camera and 
microphone
For use on computer models without Web camera 
and microphone
For use on computer models sold at Best Buy

412378-001

412377-001

417665-001
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

6 Fan/heat sink assembly (includes thermal pad) 412397-001

7 Processors (include thermal pad)

Intel Core Duo T2500 (2.00-GHz)
Intel Core Duo T2400 (1.83-GHz)
Intel Core Duo T2300E (1.66-GHz)
Intel Core Duo T2250 (1.73-GHz)
Intel Core Duo T2300 (1.66-GHz)
Intel Core Duo T2050 (1.60-GHz)

412333-001
412334-001
419437-001
430897-001
412335-001
430898-001

Intel Core Solo T1350 (1.86-GHz)
Intel Core Solo T1300 (1.66-GHz)

430896-001
412332-001

Intel Celeron M 410 (1.46-GHz) 419436-001

Plastics Kit

For use on computer models not sold at Best Buy
For use on computer models sold at Best Buy

412384-001
417667-001

8a
8b
8c
8d

Includes:
ExpressCard slot bezel
Hard drive cover (includes two captive screws)
Mini Card compartment cover (includes 2 captive screws)
Memory module compartment cover (includes 2 captive screws)

9 ExpressCard assembly 412330-001

10 System boards

945GM for use on computer models with Web 
camera and microphone
945GM for use on computer models without Web 
camera and microphone
945GM for use on computer models sold at Best Buy

430894-001

430893-001

430895-001
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

10 System boards (Continued)

940GML for use on computer models with Web 
camera and microphone
940GM for use on computer models without Web 
camera and microphone

430892-001

412238-001

11 Bluetooth® module (includes Bluetooth 
module cable)

412766-001

12 USB/S-Video board 412398-001

13 Speaker assembly 412395-001

14 Menu control button board (includes bracket 
and cable)

412401-001

15 RTC battery 412390-001

16 Base enclosure

For use on computer models with Web camera 
and microphone
For use on computer models without Web camera 
and microphone
For use on computer models sold at Best Buy

412382-001

412381-001

417666-001

Rubber Feet Kit (includes computer feet and 
display bezel rubber screw covers)

412579-001

17 Battery

12-cell, 8.8-AHr
6-cell, 4.0-AHr

396600-001
396601-001
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

18 Hard drives (include frame and connector)

5400-rpm, 100-GB
5400-rpm, 80-GB
5400-rpm, 60-GB
5400-rpm, 40-GB

412367-001
412366-001
412365-001
412364-001

19 Mini Card modules

802.11a/b/g WLAN module for use in the countries 
listed below. These countries are categorized as most 
of the world (MOW 1).

407674-001

Antigua & 
Barbuda

Argentina
Australia
Bahamas
Barbados
Brunei

Canada
Chile
Dominican 

Republic
Guam
Guatemala
Hong Kong

Panama
India
Indonesia
Malaysia
Mexico
New Zealand

Paraguay
Saudi Arabia
Taiwan
The United 

States
Vietnam
Maintenance and Service Guide 3–11



Illustrated Parts Catalog
Computer Major Components
3–12 Maintenance and Service Guide



Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

19 Mini Card modules (Continued)

802.11a/b/g WLAN module for use in the countries 
listed below. These countries are categorized as most 
of the world (MOW 2).

407674-002

Aruba
Austria
Azerbaijan
Bahrain
Belgium
Bermuda
Bulgaria
Cayman 

Islands
Columbia
Croatia
Cyprus
The Czech 

Republic
Denmark

Egypt
El Salvador
Estonia
Finland
France
Georgia
Germany
Greece
Hungary
Iceland
Ireland
Italy
Latvia
Lebanon

The Philippines
Poland
Portugal
Romania
Russia
Serbia and 

Montenegro
Singapore
Slovakia
Liechtenstein
Lithuania
Luxembourg
Malta
Monaco

The 
Netherlan
ds

Norway
Oman
Slovenia
South Africa
Spain
Sri Lanka
Sweden
Switzerland
Turkey
The United 

Kingdom
Uzbekistan

802.11a/b/g WLAN module for use in the countries 
listed below. These countries are categorized as the 
rest of the world (ROW).

407674-003

China
Ecuador
Haiti

Honduras
Pakistan
Peru

Qatar
South Korea

Uruguay
Venezuela

802.11a/b/g WLAN module for use in Japan 407674-291

802.11b/g WLAN module HS MOW 407159-001

802.11b/g WLAN module HS ROW 407159-002

802.11b/g WLAN module GL 407674-004
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Illustrated Parts Catalog
Table 3-1

Spare Parts: Computer Major Components (Continued)

Item Description
Spare Part 
Number

20 Memory modules, 1-DIMM, DDR2

PC2-5300, 667-MHz
1024 MB
512 MB
256 MB

412363-001
412362-001
412361-001

PC2-4200, 533-MHz
1024 MB
512 MB
256 MB

412360-001
412359-001
412358-001

Secure Digital (SD) Memory Cards (not illustrated)

512-MB
256-MB

407316-001
403573-001

21 Optical drives (include bezel)

24X DVD/CD-RW Combo Drive 412368-001

8X DVD±RW/R and CD-RW Double-Layer 
Combo Drive

419438-001

8X DVD±RW/R and CD-RW Double-Layer Combo 
Drive with LightScribe for use on computer models 
sold at Best Buy

419440-001

8X DVD±RW/R and CD-RW Double-Layer 
Combo Drive with LightScribe

419439-001

8X DVD±RW/R and CD-RW Double-Layer Combo 
Drive with LightScribe and “HLDS”

412373-001
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Illustrated Parts Catalog
3.3 Display Assembly Components

Display Assembly Components

Table 3-2

Display Assembly Components

Spare Part Number Information

Item Description
Spare Part 
Number

1 Display bezels
for use on computer models with Web camera and 
microphone
for use on computer models without Web camera 
and microphone

412343-001

412342-001

2 Web camera
USB camera cable (not illustrated)

412347-001
412348-001
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Illustrated Parts Catalog
3 Display Hinge Kit 412355-001

4 Display panels
14.0-inch, WXGA, SVA with BrightView
14.0-inch, WXGA
14.0-inch, WXGA, SVA with BrightView for use 
on computer models sold at Best Buy

412341-001
412340-001
414032-001

5 Display cables
for use on computer models with Web camera and 
microphone
for use on computer models without Web camera and 
microphone

412352-001

412353-001

6 Display inverter 412345-001

7 Display enclosures (include wireless antenna 
transceivers and cables)
for use on computer models with Web camera and 
microphone
for use on computer models without Web camera and 
microphone

412350-001

412349-001

Display Screw Kit (not illustrated) 417713-001

Rubber Feet Kit (includes display bezel rubber screw 
covers; not illustrated)

412579-001

Table 3-2

Display Assembly Components

Spare Part Number Information

Item Description
Spare Part 
Number
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3.4 Mass Storage Devices

Mass Storage Devices
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Table 3-3

Mass Storage Devices

Spare Part Number Information

Item Description
Spare Part 
Number

1 Hard drives (include frame and connector)

5400-rpm
100-GB
80-GB
60-GB
40-GB

412367-001
412366-001
412365-001
412364-001

2 Optical drives

24X DVD/CD-RW Combo Drive
8X DVD±RW/R and CD-RW Double-Layer Combo 
Drive
8X DVD±RW/R and CD-RW Double-Layer Combo 
Drive with LightScribe for use on computer models 
sold at Best Buy
8X DVD±RW/R and CD-RW Double-Layer Combo 
Drive with LightScribe
8X DVD±RW/R and CD-RW Double-Layer Combo 
Drive with LightScribe and “HLDS”

412368-001
419438-001

419440-001

419439-001

412373-001

USB digital drive (not illustrated) 364727-001
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3.5 Plastics Kit

Plastics Kit Contents

Table 3-4

Plastics Kit

Spare Part Number Information

Item Description
Spare Part 
Number

Plastics Kit

For use on computer models not sold at Best Buy
For use on computer models sold at Best Buy

412384-001
417667-001

1
2
3
4

Includes:
ExpressCard slot bezel
Hard drive cover
Mini Card compartment cover
Memory module compartment cover
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3.6 Miscellaneous

Table 3-5

Spare Parts: Miscellaneous (not illustrated)

Description
Spare Part 
Number

Logo Kit 412388-001

HP backpack 405527-001

Wired headset with volume control 371693-001

HP Mobile Remote Control 407313-001

USB travel mouse 309674-001

HP xc2000 Notebook All-in-One Media Cable 404577-001

HP 65W AC Adapter 402018-001

Screw Kit (includes the following screws; refer to
Appendix A, “Screw Listing,” for more information on 
specifications and usage)

412386-001

■ Phillips PM2.5×6.0 screw

■ Phillips PM2.5×4.0 screw

■ Phillips PM2.0×8.5 screw

■ Phillips PM2.0×7.0 screw

■ Black Phillips PM2.0×5.0 screw

■ Silver Phillips PM2.0×5.0 screw

■ Phillips PM2.0×3.0 screw

■ Phillips PM2.0×2.0 screw

■ Phillips PM1.5×3.5 screw

■ Phillips PM1.5×2.0 screw
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Power cords

For use in:

Australia and New Zealand 394279-011

Belgium, Europe, Finland, France, Germany, Greece, 
the Netherlands, Norway, Portugal, Spain, and Sweden

394279-021

Brazil 394279-201

Canada, French Canada, Latin America, Thailand, and 
the United States

394279-001

Denmark 394279-081

Hong Kong and the United Kingdom 394279-031

India 394279-D61

Israel 394279-BB1

Italy 394279-061

Japan 394279-291

Korea 394279-AD1

People’s Republic of China 394279-AA1

Switzerland 394279-111

Taiwan 394279-AB1

Table 3-5

Spare Parts: Miscellaneous (not illustrated) (Continued)

Description
Spare Part 
Number
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3.7 Sequential Part Number Listing

Table 3-6

Spare Parts: Sequential Part Number Listing

Spare Part 
Number Description

309674-001 USB travel mouse

364727-001 USB digital drive (not illustrated)

371693-001 Wired headset with volume control

394279-001 Power cord for use in Canada, French Canada, Latin America, 
Thailand, and the United States

394279-011 Power cord for use in Australia and New Zealand

394279-021 Power cord for use in Belgium, Europe, Finland, France, 
Germany, Greece, the Netherlands, Norway, Portugal, Spain, 
and Sweden

394279-031 Power cord for use in Hong Kong and the United Kingdom

394279-061 Power cord for use in Italy

394279-081 Power cord for use in Denmark

394279-111 Power cord for use in Switzerland

394279-201 Power cord for use in Brazil

394279-291 Power cord for use in Japan

394279-AA1 Power cord for use in the People’s Republic of China

394279-AB1 Power cord for use in Taiwan

394279-AD1 Power cord for use in Korea
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Spare Part 
Number Description

394279-BB1 Power cord for use in Israel

394279-D61 Power cord for use in India

396600-001 12-cell, 8.8-AHr battery

396601-001 6-cell, 4.0-AHr battery

402018-001 HP 65W AC Adapter

403573-001 256-MB SD Memory Card

404577-001 HP xc2000 Notebook All-in-One Media Cable

405527-001 HP backpack

407159-001 802.11b/g WLAN Mini Card module HS MOW

407159-002 802.11b/g WLAN Mini Card module HS ROW

407313-001 HP Mobile Remote Control

407316-001 512-MB SD Memory Card

407674-001 802.11a/b/g WLAN Mini Card module for use in the MOW 1 
countries listed below.

Antigua & 
Barbuda

Argentina
Australia
Bahamas
Barbados
Brunei

Canada
Chile
Dominican 

Republic
Guam
Guatemala

Hong Kong
Panama
India
Indonesia
Malaysia
Mexico

New Zealand
Paraguay
Saudi Arabia
Taiwan
The United States
Vietnam

Table 3-6

Spare Parts: Sequential Part Number Listing (Continued)
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Spare Part 
Number Description

407674-002 802.11a/b/g WLAN Mini Card module for use in the MOW 2 
countries listed below.

Aruba
Austria
Azerbaijan
Bahrain
Belgium
Bermuda
Bulgaria
Cayman 

Islands
Columbia
Croatia
Cyprus
The Czech 

Republic

Denmark
Egypt
El Salvador
Estonia
Finland
France
Georgia
Germany
Greece
Hungary
Iceland
Ireland
Italy
Latvia

Lebanon
The Philippines
Poland
Portugal
Romania
Russia
Serbia and 

Montenegro
Singapore
Slovakia
Liechtenstein
Lithuania
Luxembourg
Malta

Monaco
The Netherlands
Norway
Oman
Slovenia
South Africa
Spain
Sri Lanka
Sweden
Switzerland
Turkey
The United 

Kingdom
Uzbekistan

407674-003 802.11a/b/g WLAN Mini Card module for use in the ROW 
countries listed below.

China
Ecuador
Haiti

Honduras
Pakistan
Peru

Qatar
South Korea

Uruguay
Venezuela

407674-004 802.11b/g WLAN Mini Card module GL

407674-291 802.11a/b/g WLAN Mini Card module for use Japan

Table 3-6

Spare Parts: Sequential Part Number Listing (Continued)
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Spare Part 
Number Description

412238-001 940GM system board for use on computer models without 
Web camera and microphone

412330-001 ExpressCard assembly

412332-001 Intel Core Solo T1300 (1.66-GHz) processor (includes 
thermal pad)

412333-001 Intel Core Duo T2500 (2.00-GHz) processor (includes 
thermal pad)

412334-001 Intel Core Duo T2400 (1.83-GHz) processor (includes 
thermal pad)

412335-001 Intel Core Duo T2300 (1.66-GHz) processor (includes 
thermal pad)

412336-001 14.0-inch, WXGA display assembly (includes wireless 
antenna transceivers and cables)

412338-001 14.0-inch, WXGA, SVA with BrightView display assembly 
(includes wireless transceivers and cables)

412340-001 14.0-inch, WXGA display panel

412341-001 14.0-inch, WXGA, SVA display panel with BrightView

412342-001 Display bezel for use on computer models without 
Web camera and microphone

412343-001 Display bezel for use on computer models with Web camera 
and microphone

Table 3-6

Spare Parts: Sequential Part Number Listing (Continued)
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Spare Part 
Number Description

412345-001 Display inverter

412347-001 Web camera

412348-001 USB camera cable

412349-001 Display enclosure for use on computer models without 
Web camera and microphone

412350-001 Display enclosure for use on computer models with Web 
camera and microphone

412352-001 Display cable for use on computer models with Web camera 
and microphone

412353-001 Display cable for use on computer models without Web 
camera and microphone

412355-001 Display hinges

412358-001 1-DIMM, DDR2, PC2-4200, 533-MHz, 256-MB 
memory module

412359-001 1-DIMM, DDR2, PC2-4200, 533-MHz, 512-MB 
memory module

412360-001 1-DIMM, DDR2, PC2-4200, 533-MHz, 1024-MB 
memory module

412361-001 1-DIMM, DDR2, PC2-5300, 667-MHz, 256-MB 
memory module

412362-001 1-DIMM, DDR2, PC2-5300, 667-MHz, 512-MB 
memory module

Table 3-6

Spare Parts: Sequential Part Number Listing (Continued)
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Spare Part 
Number Description

412363-001 1-DIMM, DDR2, PC2-5300, 667-MHz, 1024-MB 
memory module

412364-001 5400-rpm, 40-GB hard drive (includes frame and connector)

412365-001 5400-rpm, 60-GB hard drive (includes frame and connector)

412366-001 5400-rpm, 80-GB hard drive (includes frame and connector)

412367-001 5400-rpm, 100-GB hard drive (includes frame and 
connector)

412368-001 24X DVD/CD-RW Combo Drive

412373-001 8X DVD±RW/R and CD-RW Double-Layer Combo Drive 
with LightScribe and “HLDS”

412374-001 Keyboard for use in the Asia Pacific, Australia, Canada,
Hong Kong, the People’s Republic of China, and 
the United States

412374-031 Keyboard for use in the United Kingdom

412374-041 Keyboard for use in Germany

412374-051 Keyboard for use in France

412374-061 Keyboard for use in Italy

412374-071 Keyboard for use in Spain

412374-081 Keyboard for use in Denmark

412374-091 Keyboard for use in Norway

412374-111 Keyboard for use in Switzerland

Table 3-6

Spare Parts: Sequential Part Number Listing (Continued)
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Spare Part 
Number Description

412374-121 Keyboard for use in French Canada

412374-131 Keyboard for use in Portugal

412374-161 Keyboard for use in Latin America

412374-171 Keyboard for use in Saudi Arabia

412374-201 Keyboard for use in Brazil

412374-281 Keyboard for use in Thailand

412374-291 Keyboard for use in Japan

412374-A41 Keyboard for use in Belgium

412374-AB1 Keyboard for use in Taiwan

412374-AD1 Keyboard for use in Korea

412374-B31 Keyboard for use internationally

412374-BB1 Keyboard for use in Israel

412374-DJ1 Keyboard for use in Greece

412377-001 Top cover for use on computer models without Web camera 
and microphone (includes TouchPad)

412378-001 Top cover for use on computer models with Web camera 
and microphone (includes TouchPad)

412381-001 Base enclosure for use on computer models without Web 
camera and microphone

412382-001 Base enclosure for use on computer models with Web camera 
and microphone

Table 3-6

Spare Parts: Sequential Part Number Listing (Continued)
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Spare Part 
Number Description

412384-001 Plastics Kit

412386-001 Screw Kit

412388-001 Logo Kit

412390-001 RTC battery

412391-001 Switch cover for use on computer models with wireless 
capability (includes wireless button and light)

412393-001 Switch cover for use on computer models without wireless 
capability (includes wireless button and light)

412395-001 Speaker assembly

412397-001 Fan/heat sink assembly (includes thermal pad)

412398-001 USB/S-Video board

412399-001 LED board (includes cable, not illustrated)

412401-001 Menu control button board (includes bracket and cable)

412579-001 Rubber Feet Kit (includes computer feet used on base 
enclosure and display bezel rubber screw covers)

412766-001 Bluetooth module (includes Bluetooth module cable)

414032-001 14.0-inch, WXGA, SVA display panel with BrightView for use 
on computer models sold at Best Buy

419438-001 8X DVD±RW/R and CD-RW Double-Layer Combo Drive

419439-001 8X DVD±RW/R and CD-RW Double-Layer Combo Drive 
with LightScribe

Table 3-6

Spare Parts: Sequential Part Number Listing (Continued)
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Spare Part 
Number Description

419440-001 8X DVD±RW/R and CD-RW Double-Layer Combo Drive 
with LightScribe for use on computer models sold at 
Best Buy

417665-001 Top cover for use on computer models sold at Best Buy

417666-001 Base enclosure for use on computer models sold at 
Best Buy

417667-001 Plastics Kit for use on computer models sold at Best Buy

417713-001 Display Screw Kit

418238-01 Switch cover for use on computer models with wireless 
capability sold at Best Buy (includes wireless button and 
light)

419436-001 Intel Celeron M 410 (1.46-GHz) processor (includes 
thermal pad)

419437-001 Intel Core Duo T2300E (1.66-GHz) processor (includes 
thermal pad)

430892-001 940GML system board for use on computer models with 
Web camera and microphone

430893-001 945GM system board for use on computer models without 
Web camera and microphone

430894-001 945GM system board for use on computer models with 
Web camera and microphone

430895-001 945GM system board for use on computer models sold at 
Best Buy

430896-001 Intel Core Solo T1350 (1.86-GHz) processor (includes 
thermal pad)

Table 3-6

Spare Parts: Sequential Part Number Listing (Continued)
Maintenance and Service Guide 3–31



Illustrated Parts Catalog
Spare Part 
Number Description

430897-001 Intel Core Duo T2250 (1.73-GHz) processor (includes 
thermal pad)

430898-001 Intel Core Duo T2250 (1.60-GHz) processor (includes 
thermal pad)

431091-001 14.0-inch, WXGA display assembly with Web camera 
(includes wireless antenna transceivers and cables)

431827-001 14.0-inch, WXGA, SVA with BrightView display assembly with 
Web camera (includes wireless transceivers and cables)

Table 3-6

Spare Parts: Sequential Part Number Listing (Continued)
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4
Removal and Replacement

Preliminaries

This chapter provides essential information for proper and 
safe removal and replacement service.y

4.1 Tools Required
You will need the following tools to complete the removal and 
replacement procedures:
■ Magnetic screwdriver
■ Phillips P0 and P1 screwdrivers
■ Flat-bladed screwdriver
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4.2 Service Considerations
The following sections include some of the considerations 
that you should keep in mind during disassembly and assembly 
procedures.

✎ As you remove each subassembly from the computer, place 
the subassembly (and all accompanying screws) away from 
the work area to prevent damage.

Plastic Parts

Using excessive force during disassembly and reassembly can 
damage plastic parts. Use care when handling the plastic parts. 
Apply pressure only at the points designated in the maintenance 
instructions.

Cables and Connectors

Ä
CAUTION: When servicing the computer, ensure that cables are 
placed in their proper locations during the reassembly process. 
Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. 
Apply only the tension required to unseat or seat the cables 
during removal and insertion. Handle cables by the connector 
whenever possible. In all cases, avoid bending, twisting, or 
tearing cables. Ensure that cables are routed in such a way that 
they cannot be caught or snagged by parts being removed or 
replaced. Handle flex cables with extreme care; these cables 
tear easily.
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4.3 Preventing Damage to 
Removable Drives
Removable drives are fragile components that must be handled 
with care. To prevent damage to the computer, damage to a 
removable drive, or loss of information, observe the following 
precautions:
■ Before removing or inserting a hard drive, shut down the 

computer. If you are unsure whether the computer is off or 
in Hibernation, turn the computer on, and then shut it down 
through the operating system.

■ Before removing a diskette drive or optical drive, ensure that 
a diskette or disc is not in the drive and ensure that the optical 
drive tray is closed.

■ Before handling a drive, ensure that you are discharged of 
static electricity. While handling a drive, avoid touching the 
connector.

■ Handle drives on surfaces covered with at least one inch of 
shock-proof foam.

■ Avoid dropping drives from any height onto any surface.
■ After removing a hard drive, CD-ROM drive, or a diskette 

drive, place it in a static-proof bag.
■ Avoid exposing a hard drive to products that have magnetic 

fields, such as monitors or speakers.
■ Avoid exposing a drive to temperature extremes or liquids.
■ If a drive must be mailed, place the drive in a bubble pack 

mailer or other suitable form of protective packaging and label 
the package, “FRAGILE: Handle With Care.”
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4.4 Preventing Electrostatic Damage
Many electronic components are sensitive to electrostatic 
discharge (ESD). Circuitry design and structure determine the 
degree of sensitivity. Networks built into many integrated circuits 
provide some protection, but in many cases, the discharge 
contains enough power to alter device parameters or melt 
silicon junctions.

A sudden discharge of static electricity from a finger or other 
conductor can destroy static-sensitive devices or microcircuitry. 
Often the spark is neither felt nor heard, but damage occurs.

An electronic device exposed to electrostatic discharge might 
not be affected at all and can work perfectly throughout a normal 
cycle. Or the device might function normally for a while, then 
degrade in the internal layers, reducing its life expectancy.
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4.5 Packaging and Transporting 
Precautions
Use the following grounding precautions when packaging and 
transporting equipment:
■ To avoid hand contact, transport products in static-safe 

containers, such as tubes, bags, or boxes.
■ Protect all electrostatic-sensitive parts and assemblies with 

conductive or approved containers or packaging.
■ Keep electrostatic-sensitive parts in their containers until 

the parts arrive at static-free workstations.
■ Place items on a grounded surface before removing items 

from their containers.
■ Always be properly grounded when touching a sensitive 

component or assembly.
■ Store reusable electrostatic-sensitive parts from assemblies 

in protective packaging or nonconductive foam.
■ Use transporters and conveyors made of antistatic belts and 

roller bushings. Ensure that mechanized equipment used for 
moving materials is wired to ground and that proper materials 
are selected to avoid static charging. When grounding is not 
possible, use an ionizer to dissipate electric charges.
Maintenance and Service Guide 4–5



Removal and Replacement Preliminaries
4.6 Workstation Precautions
Use the following grounding precautions at workstations:
■ Cover the workstation with approved static-shielding material 

(refer to Table 4-2, “Static-Shielding Materials”).
■ Use a wrist strap connected to a properly grounded work 

surface and use properly grounded tools and equipment.
■ Use conductive field service tools, such as cutters, 

screwdrivers, and vacuums.
■ When using fixtures that must directly contact dissipative 

surfaces, only use fixtures made of static-safe materials.
■ Keep the work area free of nonconductive materials, such 

as ordinary plastic assembly aids and Styrofoam.
■ Handle electrostatic-sensitive components, parts, and 

assemblies by the case or PCM laminate. Handle these 
items only at static-free workstations.

■ Avoid contact with pins, leads, or circuitry.
■ Turn off power and input signals before inserting or removing 

connectors or test equipment.
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4.7 Grounding Equipment and 
Methods
Grounding equipment must include either a wrist strap or a 
foot strap at a grounded workstation.
■ When seated, wear a wrist strap connected to a grounded 

system. Wrist straps are flexible straps with a minimum of 
one megohm ±10% resistance in the ground cords. To provide 
proper ground, wear a strap snugly against the skin at all times. 
On grounded mats with banana-plug connectors, use alligator 
clips to connect a wrist strap.

■ When standing, use foot straps and a grounded floor mat. 
Foot straps (heel, toe, or boot straps) can be used at standing 
workstations and are compatible with most types of shoes 
or boots. On conductive floors or dissipative floor mats, use 
foot straps on both feet with a minimum of one megohm 
resistance between the operator and ground. To be effective, 
the conductive strips must be worn in contact with the skin.

Other grounding equipment recommended for use in preventing 
electrostatic damage includes
■ Antistatic tape.
■ Antistatic smocks, aprons, and sleeve protectors.
■ Conductive bins and other assembly or soldering aids.
■ Nonconductive foam.
■ Conductive tabletop workstations with ground cords of 

one megohm resistance.
■ Static-dissipative tables or floor mats with hard ties to 

the ground.
■ Field service kits.
■ Static awareness labels.
■ Material-handling packages.
■ Nonconductive plastic bags, tubes, or boxes.
■ Metal tote boxes.
■ Electrostatic voltage levels and protective materials.
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Table 4-1 shows how humidity affects the electrostatic voltage 
levels generated by different activities.

Table 4-2 lists the shielding protection provided by antistatic 
bags and floor mats.

Table 4-1

Typical Electrostatic Voltage Levels

Relative Humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V  5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

✎ A product can be degraded by as little as 700 V.

Table 4-2

Static-Shielding Materials

Material Use Voltage Protection Level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Removal and Replacement

Procedures

This chapter provides removal and replacement procedures.

There are as many as 89 screws, in 10 different sizes, that must be 
removed, replaced, or loosened when servicing the computer. 
Make special note of each screw size and location during removal 
and replacement.

Refer to Appendix A, “Screw Listing,” for detailed information 
on screw sizes, locations, and usage.
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5.1 Serial Number
Report the computer serial number to HP when requesting 
information or ordering spare parts. The serial number is 
located on the bottom of the computer.

Serial Number Location
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5.2 Disassembly Sequence Chart
Use the chart below to determine the section number to be 
referenced when removing computer components.

Disassembly Sequence Chart

Section Description # of Screws Removed

5.3 Preparing the Computer for 
Disassembly

Battery 0

5.4 Hard Drive 2 loosened to remove the hard 
drive cover
4 removed to disassemble the 
hard drive

5.5 Computer Feet 0

5.6 Memory Module 2 loosened to remove the 
memory module compartment 
cover

5.7 Mini Card Module 1 loosened to remove the 
Mini Card module 
compartment cover
2 removed to remove the 
Mini Card

Ä To prevent an unresponsive system and the display of a 
warning message, install only a Mini Card device 
authorized for use in your computer by the governmental 
agency that regulates wireless devices in your country. If 
you install a device and then receive a warning message, 
remove the device to restore computer functionality. Then 
contact Customer Care.

5.8 Optical Drive 1 to remove the optical drive
2 to remove the optical drive 
bracket

5.9 Switch Cover 3

5.10 Keyboard 2
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5.3 Preparing the Computer for 
Disassembly
Before you begin any removal or installation procedures: 

1. Shut down the computer. If you are unsure whether the 
computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

Section Description # of Screws Removed

5.11 Display Assembly
Display bezel
Web camera
Display release hooks
Display inverter
Display panel
Display hinges
Wireless antenna transceivers

4
6
0
4
1
6
4
4

5.12 Base Enclosure 20

5.13 USB/S-Video Board 2

5.14 Bluetooth Module 2

5.15 Speaker Assembly 0

5.16 RTC Battery 0

5.17 Menu Control Button Board 4

5.18 Fan/Heat Sink Assembly 4

5.19 Processor 1 loosened

5.20 System Board 3

5.21 LED Board 3

5.22 ExpressCard Assembly 2

Disassembly Sequence Chart (Continued)
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2. Disconnect all external devices connected to the computer.

3. Disconnect the power cord.

4. Remove the battery by following these steps:

a. Turn the computer upside down with the front panel 
toward you.

b. Slide and hold the battery release latch 1 to the left. 
(The front edge of the battery disengages from 
the computer.)

c. Lift the front edge of the battery 2 up and swing it back.
d. Remove the battery.

Removing the Battery

Reverse the above procedure to install the battery.

Battery Spare Part Number Information

12-cell, 8.8-AHr
6-cell, 4.0-AHr

396600-001
396601-001
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5.4 Hard Drive

1. Prepare the computer for disassembly (refer to Section 5.3).

Hard Drive Spare Part Number Information

Frame and connector included.

5400-rpm, 100-GB
5400-rpm, 80-GB
5400-rpm, 60-GB
5400-rpm, 40-GB

412367-001
412366-001
412365-001
412364-001
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2. Loosen the two black Phillips PM2.5×5.0 screws 1 that 
secure the hard drive cover to the computer.

3. Lift the left side of the cover 2 and swing it to the right.

4. Remove the hard drive cover.

✎ The hard drive cover is included in the Plastics Kits, spare part 
number 412384-001 for computer models not sold at Best Buy, 
and spare part number 417666-001 for computer models sold 
at Best Buy.

Removing the Hard Drive Cover
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5. Use the mylar tab 1 to lift the hard drive 2 until it 
disconnects from the computer.

6. Remove the hard drive from the hard drive bay.

Removing the Hard Drive
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7. Remove the four Phillips PM2.5×4.0 screws 1 that secure 
the hard drive frame to the hard drive.

8. Lift the frame 2 straight up to remove if from the hard drive.

9. Slide the hard drive connector 3 off the hard drive.

Removing the Hard Drive Frame and Connector

Reverse the above procedure to install and reassemble the 
hard drive.
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5.5 Computer Feet
The computer feet are adhesive-backed rubber pads. The feet are 
included in the Rubber Feet Kit, spare part number 412579-001. 
The feet attach to the base enclosure as illustrated below.

Replacing the Computer Feet
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5.6 Memory Module

1. Prepare the computer for disassembly (refer to Section 5.3).

Memory Module Spare Part Number Information

PC2-5300, 667-MHz
1024 MB
512 MB
256 MB

412363-001
412362-001
412361-001

PC2-4200, 533-MHz
1024 MB
512 MB
256 MB

412360-001
412359-001
412358-001
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2. Loosen the two black Phillips PM2.5×5.0 screws 1 that 
secure the memory module compartment cover to the 
computer.

3. Lift the front edge of the memory module compartment 
cover 2 up and swing it back.

4. Remove the memory module compartment cover.

✎ The memory module compartment cover is included in the 
Plastics Kit, spare part number 412384-001 for computer 
models not sold at Best Buy, and spare part number 
417666-001 for computer models sold at Best Buy.

Removing the Memory Module Compartment Cover
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5. Spread the retaining tabs 1 on each side of the memory 
module socket to release the memory module. (The edge 
of the module opposite the socket rises away from the 
computer.)

6. Slide the module 2 away from the socket at an angle.

✎ Memory modules are designed with a notch 3 to prevent 
incorrect installation into the memory module socket.

Removing the Memory Module

Reverse the above procedure to install a memory module.
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5.7 Mini Card Module

Mini Card Module

Spare Part Number Information

802.11a/b/g WLAN module for use in the MOW 1 countries 
listed below.

407674-001

Antigua & 
Barbuda

Argentina
Australia
Bahamas
Barbados
Brunei

Canada
Chile
Dominican 

Republic
Guam
Guatemala

Hong Kong
Panama
India
Indonesia
Malaysia
Mexico

New Zealand
Paraguay
Saudi Arabia
Taiwan
The United States
Vietnam

802.11a/b/g WLAN module for use in the MOW 2 countries 
listed below.

407674-002

Aruba
Austria
Azerbaijan
Bahrain
Belgium
Bermuda
Bulgaria
Cayman Islands
Columbia
Croatia
Cyprus
The Czech 

Republic
Denmark

Egypt
El Salvador
Estonia
Finand
France
Georgia
Germany
Greece
Hungary
Iceland
Ireland
Italy
Latvia
Lebanon

The Phillippines
Poland
Portugal
Romania
Russia
Serbia and 

Montenegro
Singapore
Slovakia
Liechtenstein
Lithuania
Luxembourg
Malta
Monaco

The Netherlands
Norway
Oman
Slovenia
South Africa
Spain
Sri Lanka
Sweden
Switzerland
Turkey
The United 

Kingdom
Uzbekistan
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Removal and Replacement Procedures
1. Prepare the computer for disassembly (Section 5.3).

802.11a/b/g WLAN module for use in the ROW countries 
listed below.

407674-003

China
Ecuador
Haiti

Honduras
Pakistan
Peru

Qatar
South Korea

Uruguay
Venezuela

802.11a/b/g WLAN module for use in Japan 407674-291

802.11b/g WLAN module HS MOW 407159-001

802.11b/g WLAN module HS ROW 407159-002

802.11b/g WLAN module GL 407674-004

Mini Card Module

Spare Part Number Information (Continued)
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Removal and Replacement Procedures
2. Loosen the black Phillips PM2.5×5.0 screw 1 that secures 
the Mini Card compartment cover to the computer.

3. Lift the rear edge of the Mini Card compartment cover 2 up, 
and then swing it forward.

4. Remove the Mini Card compartment cover.

✎ The Mini Card compartment cover is included in the Plastics 
Kit, spare part number 412384-001 for computer models not 
sold at Best Buy, and spare part number 417666-001 for 
computer models sold at Best Buy.

Removing the Mini Card Compartment Cover
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Removal and Replacement Procedures
5. Make note of which wireless antenna cable is attached to 
which antenna clip on the Mini Card module before 
disconnecting the cables, then disconnect the cables 1 from 
the module.

6. Remove the two Phillips PM2.5×6.0 screws 2 that secure the 
Mini Card module to the computer. (The edge of the module 
opposite the socket rises away from the computer).

7. Remove the module 3 by pulling it away from the socket at 
an angle.

✎ Mini Card modules are designed with a notch 4 to prevent 
incorrect installation into the Mini Card module socket.

Removing a Mini Card Module

Reverse the above procedure to install a Mini Card module.
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Removal and Replacement Procedures
5.8 Optical Drive

1. Prepare the computer for disassembly (Section 5.3).

Optical Drive Spare Part Number Information

24X DVD/CD-RW Combo Drive
8X DVD±RW/R and CD-RW Double-Layer Combo Drive
8X DVD±RW/R and CD-RW Double-Layer Combo Drive with 
LightScribe for use on computer models sold at Best Buy
8X DVD±RW/R and CD-RW Double-Layer Combo Drive with 
LightScribe
8X DVD±RW/R and CD-RW Double-Layer Combo Drive with 
LightScribe and “HLDS”

412368-001
419438-001
419440-001

419439-001

412373-001
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Removal and Replacement Procedures
2. Remove the Phillips PM2.5×8.5 screw 1 that secures the 
optical drive to the computer.

3. Insert a thin tool, such as a paper clip, into the media tray 
release hole 2. (The optical drive media tray releases from 
the optical drive.)

4. Use the media tray frame to slide the optical drive 3 to 
the left.

5. Remove the optical drive.

Removing the Optical Drive
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Removal and Replacement Procedures
6. Position the optical drive with the optical drive bracket 
toward you.

7. Remove the two Phillips Phillips PM2.0×3.0 screws 1 that 
secure the optical drive bracket to the optical drive.

8. Remove the optical drive 2.

Removing the Optical Drive Bracket

Reverse the above procedure to reassemble and install the 
optical drive.
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Removal and Replacement Procedures
5.9 Switch Cover

1. Prepare the computer for disassembly (Section 5.3).

2. Position the computer with the rear panel toward you.

3. Remove the three silver Phillips PM2.5×5.0 screws that 
secure the switch cover to the computer.

Removing the Switch Cover Screws

Switch Cover Spare Part Number Information

For use on computer models with wireless capability
For use on computer models without wireless capability
For use on computer models with wireless capability sold at 
Best Buy

412391-001
412393-001
418238-001
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Removal and Replacement Procedures
4. Turn the computer display side up with the front toward you.

5. Open the computer as far as possible.

6. Insert a flat-bladed screwdriver under the outside edges of 
the display hinge covers.

7. Lift up on the outside edges of the hinge covers 1 until the 
switch cover 2 disengages from the computer.

Releasing the Switch Cover
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Removal and Replacement Procedures
8. Swing the rear edge of the switch cover forward.

9. Remove the switch cover.

Removing the Switch Cover

Reverse the above procedure to install the switch cover.
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Removal and Replacement Procedures
5.10 Keyboard

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the optical drive (Section 5.8).

3. Remove the switch cover (Section 5.9).

4. Close the computer.

5. Turn the computer upside down with the front toward you.

Keyboard Spare Part Number Information

Belgium
Brazil
Denmark
France
French Canada
Germany
Greece
Israel
International
Italy
Japan
Korea
Latin America

412374-A41
412374-201
412374-081
412374-051
412374-121
412374-041
412374-DJ1
412374-BB1
412374-B31
412374-AD1
412374-291
412374-AD1
412374-161

Norway
Portugal
Saudi Arabia
Spain
Switzerland
Taiwan
Thailand
The United Kingdom
Asia Pacific, Australia, 

Canada,
Hong Kong, 
the People’s Republic
of China, and the 
United States

412374-091
412374-131
412374-171
412374-071
412374-111
412374-AB1
412374-281
412374-031
412374-001
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Removal and Replacement Procedures
6. Remove the two silver Phillips PM2.5×5.0 screws that secure 
the keyboard to the computer.

Removing the Keyboard Screws
Maintenance and Service Guide 5–25



Removal and Replacement Procedures
7. Turn the computer display side up with the front panel 
toward you.

8. Open the computer as far as possible.

9. Lift the rear edge of the keyboard and swing it forward until 
it rests on the palm rest.

Releasing the Keyboard
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Removal and Replacement Procedures
10. Release the zero insertion force (ZIF) connector 1 to which 
the keyboard cable is connected and disconnect the keyboard 
cable 2 from the system board.

Disconnecting the Keyboard Cable

11. Remove the keyboard.

Reverse the above procedure to install the keyboard.
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Removal and Replacement Procedures
5.11 Display Assembly

1. Prepare the computer for disassembly (Section 5.3).

2. Remove the memory module compartment (Section 5.6) and 
Mini Card compartment covers (Section 5.7).

Display Assembly Spare Part Number Information

With Web camera
14.0-inch, WXGA, SVA with BrightView
14.0-inch, WXGA

431091-001
431827-001

Without Web camera
14.0-inch, WXGA, SVA with BrightView
14.0-inch, WXGA

412338-001
412336-001
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Removal and Replacement Procedures
3. Disconnect the wireless antenna cables 1 from the 
Mini Card module.

4. Disconnect the microphone cable 2 from the system board.

Disconnecting the Wireless Antenna Cables and 
Microphone Cables
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Removal and Replacement Procedures
5. Remove the switch cover (Section 5.9).

6. Remove the keyboard (Section 5.10).

7. Turn the computer display side up with the front toward you.

8. Open the display as far as possible.

9. Disconnect the display 1 and Web camera cables 2 from 
the system board.

10. Remove the cables 3 from the clips 4 and 5 in the 
top cover.

Disconnecting the Display and Web Camera Cables and 
Removing the Wireless Antenna Cables
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Removal and Replacement Procedures
Ä
CAUTION: Support the display assembly when removing the following 
screws. Failure to support the display assembly can result in damage to 
the display assembly and other computer components.

11. Remove the four Phillips PM2.5×7.0 screws 1 that secure 
the display assembly to the computer.

12. Remove the display assembly 2.

Removing the Display Assembly
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Removal and Replacement Procedures
13. Remove the six rubber screw covers 1 and the six Phillips 
PM2.5×6.0 screws 2 that secure the display bezel to the 
display assembly.

✎ The display bezel rubber screw covers are included in the 
Rubber Feet Kit, spare part number 412579-001.

Removing the Display Bezel Screws
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Removal and Replacement Procedures
14. Flex the insides edges of the left and right sides 1 and the 
top and bottom sides 2 of the display bezel until the bezel 
disengages from the display enclosure.

15. Remove the display bezel 3.

Removing the Display Bezel

Display Assembly Subcomponents

Spare Part Number Information

Display bezels
For use on computer models with Web camera and 
microphone
For use on computer models without Web camera 
and microphone

412343-001
412342-001

Display enclosures (include wireless antenna transceivers and 
cables and microphone and cable)
For use on computer models with Web camera 
and microphone
For use on computer models without Web camera and 
microphone

412350-001
412349-001
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Removal and Replacement Procedures
16. If it is necessary to replace the display Web camera, 
disconnect the camera cable 1 from the camera board, and 
then remove the camera board 2 from the display enclosure.

Removing the Display Web Camera

Display Assembly Subcomponents

Spare Part Number Information

Web camera board
USB camera cable (not illustrated)

412347-001
412348-001
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Removal and Replacement Procedures
✎ The display release hooks are available in the Display Hinge 
Kit, spare part number 412355-001.

17. If it is necessary to replace the display release hooks, remove 
the two Phillips PM2.5×6.0 screws 1 that secure each hook 
to the display enclosure.

18. Remove the display release hooks 2.

Removing the Display Release Hooks
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Removal and Replacement Procedures
19. Remove the Phillips PM2.0×3.0 screw 1 that secures the 
display inverter to the display enclosure.

20. Lift the inverter 2 out of the enclosure as far as the display 
cable and backlight cables will allow.

21. Disconnect the display 3 and backlight cables 4 from 
the inverter.

22. Remove the inverter.

Removing the Display Inverter

Display Assembly Subcomponents

Spare Part Number Information

Display inverter 412345-001
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Removal and Replacement Procedures
23. Remove the two Phillips PM2.5×5.0 screws 1 and the four 
Phillips PM2.5×6.0 screws 2 that secure the display panel 
to the display enclosure.

24. Remove the display panel 3 from the display enclosure.

Removing the Display Panel

Display Assembly Subcomponents

Spare Part Number Information

Display panels
14.0-inch, WXGA, SVA with BrightView
14.0-inch, WXGA
14.0-inch, WXGA, SVA with BrightView for use on computer 
models sold at Best Buy

412341-001
412340-001
414032-001
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Removal and Replacement Procedures
25. If it is necessary to replace the display hinges, remove the 
two Phillips PM2.0×3.0 screws 1 that secure each hinge 
to the display panel.

26. Remove the display hinges 2.

Removing the Display Hinges

Display Assembly Subcomponents

Spare Part Number Information

Display Hinge Kit 412355-001
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Removal and Replacement Procedures
✎ The wireless antenna transceivers and cables are included in 
tthe display enclosure spare part kits, spare part numbers 
412350-001 and 412349-001.

27. If it is necessary to replace the wireless transceivers and 
cables, remove the two Phillips PM2.0×3.0 screws 1 that 
secure the left and right transceivers to the display enclosure.

28. Release the retention tabs 2 built in to the display enclosure 
lining that secure the wireless antenna cables to the display 
enclosure.

29. Detach the wireless antenna transceivers 3 from the 
display enclosure.

30. Remove the wireless antenna transceivers and cables 4.

Removing the Wireless Antenna Transceivers and Cables
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Removal and Replacement Procedures
✎ The microphone and cable are included in tthe display 
enclosure spare part kits, spare part numbers 412350-001 and 
412349-001.

31. If it is necessary to replace the microphone and cable, release 
the retention tabs 1 built in to the display enclosure lining 
that secure the wireless antenna cables to the display 
enclosure.

32. Remove the microphone from the clip 2 in the 
display enclosure.

33. Detach the microphone cable 3 from the display enclosure.

Removing the Microphone

Reverse the above procedure to reassemble and install the 
display assembly
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Removal and Replacement Procedures
5.12 Base Enclosure

1. Prepare the computer for disassembly (Section 5.3) 
and remove the following components:

❏ Hard drive (Section 5.4)

❏ Optical drive (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Keyboard (Section 5.10)

❏ Display assembly (Section 5.11)

Base Enclosure Spare Part Number Information

For use on computer models with Web camera and 
microphone
For use on computer models without Web camera and 
microphone
For use on computer models sold at Best Buy
Rubber Feet Kit (includes computer feet)

412382-001
412381-001
417666-001
412579-001
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Removal and Replacement Procedures
2. Remove the two Phillips PM2.5×8.5 screws that secure the 
base enclosure to the computer

Removing the Base Enclosure Screws, Part 1
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Removal and Replacement Procedures
3. Turn the computer upside down with the front toward you.

4. Remove the fourteen Phillips PM2.5×8.5 screws that secure 
the base enclosure to the computer.

Removing the Base Enclosure Screws, Part 2
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Removal and Replacement Procedures
5. Remove the four silver Phillips PM2.5×5.0 screws that 
secure the base enclosure to the computer.

Removing the Base Enclosure Screws, Part 3
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Removal and Replacement Procedures
6. Swing the rear edge 1 of the base enclosure straight up and 
forward until it rests at an angle.

7. Slide the base enclosure 2 back at an angle.

8. Remove the base enclosure.

Removing the Base Enclosure

Reverse the above procedure to install the base enclosure.
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Removal and Replacement Procedures
5.13 USB/S-Video Board

1. Prepare the computer for disassembly (Section 5.3) 
and remove the following components:

❏ Optical drive (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Keyboard (Section 5.10)

❏ Display assembly (Section 5.11)

❏ Base enclosure (Section 5.12)

USB/S-Video Board

Spare Part Number Information

USB/S-Video Board 412398-001
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Removal and Replacement Procedures
2. Remove the two silver Phillips PM2.5×5.0 screws 1 that 
secure the USB/S-Video board to the top cover.

3. Lift up on the right side of the board 2 to disconnect it from 
the system board.

4. Remove the USB/S-Video board.

Removing the USB/S-Video Board

Reverse the above procedure to install the USB/S-Video board.
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Removal and Replacement Procedures
5.14 Bluetooth Module

1. Prepare the computer for disassembly (Section 5.3) 
and remove the following components:

❏ Optical drive (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Keyboard (Section 5.10)

❏ Display assembly (Section 5.11)

❏ Base enclosure (Section 5.12)

❏ USB/S-Video board (Section 5.13)

Bluetooth Module Spare Part Number Information

Bluetooth module (includes Bluetooth module cable) 412766-001
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Removal and Replacement Procedures
2. Turn the USB/S-Video board upside down with the 
USB port facing you.

3. Remove the two Phillips PM1.5×3.5 screws 1 that secure 
the Bluetooth module to the USB/S-Video board.

4. Disconnect the Bluetooth module cable 2 from the 
USB/S-Video board.

5. Remove the Bluetooth module 3.

Removing the Bluetooth Module

Reverse the above procedure to install the Bluetooth module.
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Removal and Replacement Procedures
5.15 Speaker Assembly

1. Prepare the computer for disassembly (Section 5.3) 
and remove the following components:

❏ Optical drive (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Keyboard (Section 5.10)

❏ Display assembly (Section 5.11)

❏ Base enclosure (Section 5.12)

Speaker Assembly Spare Part Number Information

Speaker assembly 412395-001
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Removal and Replacement Procedures
2. Disconnect the speaker cable 1 from the system board.

3. Lift the speaker 2 straight up to remove it from the top cover.

Removing the Speaker Assembly

Reverse the above procedure to install the speaker assembly.
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Removal and Replacement Procedures
5.16 RTC Battery

1. Prepare the computer for disassembly (Section 5.3) 
and remove the following components:

❏ Optical drive (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Keyboard (Section 5.10)

❏ Display assembly (Section 5.11)

❏ Base enclosure (Section 5.12)

RTC Battery Spare Part Number Information

RTC Battery 412390-001
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Removal and Replacement Procedures
2. Remove the RTC battery from the socket on the 
system board.

Removing the RTC Battery

Reverse the above procedure to install the RTC battery. Be sure 
that the RTC battery is installed with the “+” sign facing up.
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Removal and Replacement Procedures
5.17 Menu Control Button Board

1. Prepare the computer for disassembly (Section 5.3) 
and remove the following components:

❏ Optical drive (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Keyboard (Section 5.10)

❏ Display assembly (Section 5.11)

❏ Base enclosure (Section 5.12)

2. Position the top cover with the front panel toward you.

Menu Control Button Board Spare Part Number Information

Menu control button board (includes bracket and cable) 412401-001
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Removal and Replacement Procedures
3. Remove the tape 1 that secures the menu control button 
board cable to the system board.

4. Release the ZIF connector 2 to which the menu control 
button board cable is connected and disconnect the cable 3.

Disconnecting the Menu Control Button Board Cable
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Removal and Replacement Procedures
5. Remove the four Phillips PM2.5×3.0 screws 1 that secure 
the menu control button board and shield to the top cover.

6. Remove the menu control button board shield 2 and 
board 3.

Removing the Menu Control Button Board and Shield

Reverse the above procedure to install the menu control button 
board and shield.
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Removal and Replacement Procedures
5.18 Fan/Heat Sink Assembly

1. Prepare the computer for disassembly (Section 5.3) 
and remove the following components:

❏ Optical drive (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Keyboard (Section 5.10)

❏ Display assembly (Section 5.11)

❏ Base enclosure (Section 5.12)

2. Turn the computer upside down with the front toward you.

Fan/Heat Sink Assembly Spare Part Number Information

Fan/heat sink assembly (includes thermal pad) 412397-001
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Removal and Replacement Procedures
3. Disconnect the fan cable 1 from the system board.

4. Loosen the four Phillips PM2.5×5.0 screws 2 that secure 
the fan/heat sink assembly to the top cover.

5. Remove the fan/heat sink assembly 3.

Removing the Fan/Heat Sink Assembly

Reverse the above procedure to install the fan/heat sink assembly.
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Removal and Replacement Procedures
5.19 Processor

1. Prepare the computer for disassembly (Section 5.3) 
and remove the following components:

❏ Optical drive (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Keyboard (Section 5.10)

❏ Display assembly (Section 5.11)

❏ Base enclosure (Section 5.12)

❏ Fan/heat sink assembly (Section 5.18)

Processor Spare Part Number Information

Intel Core Duo T2500 (2.00-GHz)
Intel Core Duo T2400 (1.83-GHz)
Intel Core Duo T2300E (1.66-GHz)
Intel Core Duo T2250 (1.73-GHz)
Intel Core Duo T2300 (1.66-GHz)
Intel Core Duo T2050 (1.60-GHz)

412333-001
412334-001
419437-001
430897-001
412335-001
430898-001

Intel Core Solo T1350 (1.86-GHz)
Intel Core Solo T1300 (1.66-GHz)

430896-001
412332-001

Intel Celeron M 410 (1.46-GHz) 419436-001
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Removal and Replacement Procedures
2. Turn the processor locking screw 1 one-half turn 
counterclockwise until you feel a click.

3. Lift the processor 2 straight up and remove it.

✎ The gold triangle 3 on the processor should be aligned in the 
front right corner when you install the processor.

Removing the Processor

Reverse the above procedure to install a processor.
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Removal and Replacement Procedures
5.20 System Board

✎ All system board spares kits include a disk cell RTC battery.

✎ When replacing the system board, ensure that the following 
components are removed from the defective system board and 
installed on the replacement system board:
■ Memory modules (Section 5.6)
■ Mini Card module (Section 5.7)
■ RTC battery (Section 5.16)
■ Menu control button board (Section 5.17)
■ Fan/heat sink assembly (Section 5.18)
■ Processor (Section 5.19)

System Board Spare Part Number Information

945GM for use on computer models with Web camera and 
microphone
945GM for use on computer models without Web camera 
and microphone
945GM for use on computer models sold at Best Buy

430894-001

430893-001

430895-001

940GML for use on computer models with Web camera and 
microphone
940GM for use on computer models without Web camera 
and microphone

430892-001

412238-001
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Removal and Replacement Procedures
1. Prepare the computer for disassembly (Section 5.3) and 
remove the following components:

❏ Hard drive (Section 5.4)

❏ Optical drive (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Keyboard (Section 5.10)

❏ Display assembly (Section 5.11)

❏ Base enclosoure (Section 5.12)

❏ USB/S-Video board (Section 5.13)

❏ Speaker assembly (Section 5.15)

2. Turn the top cover right side up with the front toward you.
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Removal and Replacement Procedures
3. Release the ZIF connector 1 to which the TouchPad cable is 
connected and disconnect the cable 2 from the system board.

Disconnecting the TouchPad Cable
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Removal and Replacement Procedures
4. Turn the top cover upside down with the front toward you.

5. Release the ZIF connector 1 to which the LED board cable is 
connected and disconnect the cable 2 from the system board.

6. Remove the three silver Phillips PM2.5×5.0 screws 3 that 
secure the system board to the top cover.

Disconnecting the LED Board Cable and Removing the System 
Board Screws
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Removal and Replacement Procedures
7. Flex and hold the left edge of the top cover 1 to the left.

8. Lift the left side of the system board 2 until the USB 3 and 
1394 connectors 4 are clear.

Releasing the System Board, Part 1
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Removal and Replacement Procedures
9. Flex and hold the front edge of the top cover 1 forward.

10. Lift the front of the system board 2 until the audio 
connectors 3 are clear.

Releasing the System Board, Part 2
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Removal and Replacement Procedures
11. Slide the system board to the left at an angle and remove it 
from the top cover.

Removing the System Board

Reverse the above procedure to install the system board.
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Removal and Replacement Procedures
5.21 LED Board

1. Prepare the computer for disassembly (Section 5.3) and 
remove the following components:

❏ Optical drive (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Keyboard (Section 5.10)

❏ Display assembly (Section 5.11)

❏ Base enclosoure (Section 5.12)

❏ USB/S-Video board (Section 5.13)

❏ Speaker assembly (Section 5.15)

❏ System board (Section 5.20)

2. Turn the computer upside down with the front panel 
toward you.

LED Board Spare Part Number Information

LED board (includes cable) 412399-001
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Removal and Replacement Procedures
3. Release the ZIF connector 1 to which the LED board cable is 
connected and disconnect the cable 2 from the system board.

4. Remove the three Phillips PM1.5×2.0 screws 3 that secure 
the LED board to the top cover.

Removing the LED Board Screws

5. Remove the LED board.

Reverse the above procedure to install the LED board.
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Removal and Replacement Procedures
5.22 ExpressCard Assembly

1. Prepare the computer for disassembly (Section 5.3) and 
remove the following components:

❏ Optical drive (Section 5.8)

❏ Switch cover (Section 5.9)

❏ Keyboard (Section 5.10)

❏ Display assembly (Section 5.11)

❏ Base enclosoure (Section 5.12)

❏ USB/S-Video board (Section 5.13)

❏ Speaker assembly (Section 5.15)

❏ System board (Section 5.20)

2. Turn the computer upside down with the ExpressCard eject 
button toward you.

ExpressCard Assembly Spare Part Number Information

ExpressCard assembly 412330-001
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Removal and Replacement Procedures
3. Remove the two Phillips PM2.0×2.0 screws that secure the 
ExpressCard assembly to the system board.

Removing the ExpressCard Assembly Screws
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Removal and Replacement Procedures
4. Turn the system board right side up with the ExpressCard 
eject button toward you.

5. Lift the back of the ExpressCard assembly to disconnect it 
from the system board.

6. Remove the ExpressCard assembly.

Removing the ExpressCard Assembly

Reverse the above procedure to install the ExpressCard assembly.
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6
Specifications

This chapter provides physical and performance specifications.

Table 6-1

Computer

Dimensions

Height (varies from front to back)
Width
Depth

3.01 cm to 3.86 cm
23.46 cm
33.40 cm

1.19 in to 1.52 in
9.24 in
13.15 in

Weight (varies by configuration) 2.44 kg 5.38 lb

Stand-alone power requirements

Operating voltage
Operating current
Peak operating power

18.5 V dc to 19.0 V dc
3.5 A or 4.74 A
65 W
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Specifications
Temperature

Operating*
Nonoperating

5°C to 35°C
-20°C to 60°C

41°F to 95°F
-4°F to 140°F

Relative humidity (noncondensing)

Operating
Nonoperating

10% to 90%
5% to 95%, 38.7°C (101.6°F) maximum 
wet bulb temperature

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia)
Nonoperating (14.7 to 4.4 psia)

-15 m to 3,048 m
-15 m to 12,192 m

-50 ft to 10,000 ft
-50 ft to 40,000 ft

Shock

Operating
Nonoperating

125 g, 2 ms, half-sine
200 g, 2 ms, half-sine

Random Vibration

Operating

Nonoperating

0.75 g zero-to-peak, 10 Hz to 500 Hz, 
0.25 oct/min sweep rate
1.50 g zero-to-peak, 10 Hz to 500 Hz, 
0.5 oct/min sweep rate

* Applicable product safety standards specify thermal limits for plastic surfaces. 
The computer operates well within this range of temperatures.

Table 6-1

Computer (Continued)
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Specifications
Table 6-2

14.0-inch, WXGA, SVA Display

Dimensions

Height
Width
Diagonal

27.94 cm
20.83 cm
35.56 cm

11.0 in
8.2 in
14.0 in

Number of colors Up to 16.8 million

Contrast ratio 250:1

Brightness 180 nits typical

Pixel resolution

Pitch
Format
Configuration

0.279 × 0.279 mm
1280 × 768
RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 4 W

Viewing angle +/-40° horizontal, +20/-40° vertical 
typical
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Specifications
Table 6-3

Hard Drives

80-GB 60-GB 60-GB 40-GB 

Dimensions

Height
Width
Weight

9.5 mm
70 mm
99 g

9.5 mm
70 mm
102 g

9.5 mm
70 mm
99 g

9.5 mm
70 mm
99 g

Interface type ATA-5 ATA-5 ATA-5 ATA-5

Transfer rate

Synchronous 
(maximum)
Security

100 MB/sec

ATA security

100 MB/sec

ATA security

100 MB/sec

ATA security

100 MB/sec

ATA
security

Seek times (typical read, including setting)

Single track
Average
Maximum

3 ms
13 ms
24 ms

3 ms
13 ms
24 ms

3 ms
13 ms
24 ms

3 ms
13 ms
24 ms

Logical blocks† 156,301,488 117,210,240 117,210,240 78,140,160

Disk rotational 
speed

5400 rpm 5400 rpm 4200 rpm 4200 rpm

Operating 
temperature

5°C to 55°C (41°F to 131°F)

✎  Certain restrictions and exclusions apply. Consult Customer Care 
for details.

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Accessible 
capacity is less.
†Actual drive specifications may differ slightly.
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Specifications
Table 6-4

Primary 6-cell, Li-Ion Battery

Dimensions

Height
Width
Depth
Weight

2.00 cm
9.40 cm
13.40 cm
0.34 kg

0.79 in
3.70 in
5.28 in
0.75 lb

Energy

Voltage
Amp-hour capacity
Watt-hour capacity

11.1 V
4.4 Ah
48 Wh

Temperature

Operating
Nonoperating

5°C to 45°C
0°C to 60°C

41°F to 113°F
32°F to 140°F
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Specifications
Table 6-5

DVD/CD-RW Combo Drive

Applicable disc Read:
DVD-R, DVD-RW, 
DVD-ROM (DVD-5, 
DVD-9, DVD-10, 
DVD-18),
CD-ROM (Mode 1 and 2)
CD Digital Audio
CD-XA ready (Mode 2, 
Form 1 and 2)
CD-I ready (Mode 2, 
Form 1 and 2)
CD-R, CD-RW
Photo CD (single and 
multisession)
CD-Bridge

Write:
CD-R and CD-RW

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc
Mini disc

12 cm (4.72 in)
8 cm (3.15 in)
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Specifications
Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD media DVD media

Random
Full stroke

< 110 ms
< 210 ms

< 130 ms
< 225 ms

Audio output level Line-out, 0.7 V rms

Cache buffer 2 MB

Data transfer rate

CD-R (24X)
CD-RW (10X)
CD-ROM (24X)
DVD (8X)
Multiword DMA mode 2

3600 KB/s (150 KB/s at 1X CD rate)
1500 KB/s (150 KB/s at 1X CD rate)
3600 KB/s (150 KB/s at 1X CD rate)
10,800 KB/s (1352 KB/s at 1X DVD rate)
16.6 MB/s

Startup time < 15 seconds

Stop time < 6 seconds

Table 6-5

DVD/CD-RW Combo Drive (Continued)
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Specifications
Table 6-6

DVD±RW/R and CD-RW Double-Layer Combo Drive

Applicable disc Read:
DVD-R, DVD-RW, 
DVD-ROM (DVD-5, 
DVD-9, DVD-10, 
DVD-18),
CD-ROM (Mode 1 and 2)
CD Digital Audio
CD-XA ready (Mode 2, 
Form 1 and 2)
CD-I ready (Mode 2, 
Form 1 and 2)
CD-R, CD-RW
Photo CD (single and 
multisession)
CD-Bridge

Write:
CD-R and CD-RW
DVD-R and DVD-RW

Center hole diameter 1.5 cm (0.59 in)

Disc diameter

Standard disc
Mini disc

12 cm (4.72 in)
8 cm (3.15 in)
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Specifications
Disc thickness 1.2 mm (0.047 in)

Track pitch 0.74 µm

Access time CD DVD

Random
Full stroke

< 175 ms
< 285 ms

< 230 ms
< 335 ms

Audio output level Audio-out, 0.7 Vrms

Cache buffer 2 MB

Data transfer rate

CD-R (16X)
CD-RW (8X)
CD-ROM (24X)
DVD (8X)
DVD-R (4X)
DVD-RW (2X)
Multiword DMA mode 2

2,400 KB/s (150 KB/s at 1X CD rate)
1,200 KB/s (150 KB/s at 1X CD rate)
3,600 KB/s (150 KB/s at 1X CD rate)
10,800 KB/s (1,352 KB/s at 1X DVD rate)
5,400 KB/s (1,352 KB/s at 1X DVD rate)
2,700 KB/s (1,352 KB/s at 1X DVD rate)
16.6 MB/s

Startup time < 15 seconds

Stop time < 6 seconds

Table 6-6

DVD±RW/R and CD-RW Double-Layer Combo Drive 
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Specifications
Table 6-7

System DMA

Hardware DMA System Function

DMA0 Not applicable

DMA1 Not applicable

DMA2 Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5 Available for ExpressCard

DMA6 Not assigned

DMA7 Not assigned
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Specifications
Table 6-8

System Interrupts

Hardware IRQ System Function

IRQ0 System timer

IRQ1 Quick Launch buttons

IRQ2 Cascaded

IRQ3 USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio
SMBus Controller—24C3
Data Fax Modem with SmartCP 

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* USB UHCI controller—24C2
GM/GME Graphic Controller
Realtek RTL8139 Family PCI fast Ethernet Controller

IRQ11 USB EHCI controller—24CD
USB UHCI controller—24C4
USB UHCI controller—24C7
Pro/Wireless 2200BG
TI OHCI 1394 host controller
TI PCI1410 CardBus controller

*Default configuration

✎ ExpressCard may assert IRQ3, IRQ4, IRQ5, IRQ7, or IRQ20.
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Specifications
Hardware IRQ System Function

IRQ12 Synaptics PS/2 port pointing device

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

IRQ17 Conexant AC -Link Audio

IRQ17 Soft V90 Data Fax Modem with SmartCP

IRQ17 ATi Mobility Radeon Xpress 200 Series

IRQ19 Standard Enhanced PCI to USB Host Controller

IRQ19 Standard OpenHCD USB Host Controller

IRQ19 Standard OpenHCD USB Host Controller

IRQ20 TI 6411 PCIxx21/x515 Cardbus Controller

IRQ20 TI OHCI Compliant IEEE 1394 Host Controller

IRQ21 TI Integrated PCIxx21 FlashMedia Controller

IRQ21 Broadcom 802.11b/g WLAN

IRQ21 Microsoft ACPI-compliant system

IRQ22 Realtek RTL8100CL Family PCI fast Ethernet 
Controller

IRQ23 SDA Standard Compliant SD Host Controller

*Default configuration

✎ ExpressCard may assert IRQ3, IRQ4, IRQ5, IRQ7, or IRQ20.

Table 6-8

System Interrupts (Continued)
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Specifications
Table 6-9

System I/O Addresses

I/O Address (hex) System Function (shipping configuration)

0x00000000-0x00000CF7 PCI bus

0x00000000-0x00000CF7 Direct memory access controller

0x00000020-0x00000021 Programmable interrupt controller

0x0000002E-0x0000002F System board resources

0x00000040-0x00000043 System timer

0x00000060-0x00000060 Quick Launch Buttons

0x00000061-0x00000061 System speaker

0x00000062-0x00000062 Microsoft ACPI-Compliant Embedded 
Controller

0x00000064-0x00000064 Quick Launch Buttons

0x00000066-0x00000066 Microsoft ACPI-Compliant Embedded 
Controller

0x00000070-0x00000071 System CMOS/real time clock

0x00000072-0x00000073 System board resources

0x00000080-0x0000008F Direct memory access controller

0x00000092-0x00000092 System board resources

0x000000A0-0x000000A1 Programmable interrupt controller

0x000000B0-0x000000B1 System board resources

0x000000C0-0x000000DF Direct memory access controller

0x000000F0-0x000000FE Numeric data processor

0x00000170-0x00000177 Secondary IDE Channel
Maintenance and Service Guide 6–13



Specifications
I/O Address (hex) System Function (shipping configuration)

0x000001F0-0x000001F7 Primary IDE Channel

0x00000220-0x0000022F System board resources

0x00000274-0x00000277 ISAPNP Read Data Port

0x00000279-0x00000279 ISAPNP Read Data Port

0x00000280-0x00000293 System board resources

0x00000376-0x00000376 Secondary IDE Channel

0x000003B0-0x000003BB PCI standard PCI-to-PCI bridge

0x000003B0-0x000003BB ATI MOBILITY RADEON Xpress 200 Series

0x000003C0-0x000003DF PCI standard PCI-to-PCI bridge

0x000003C0-0x000003DF ATI MOBILITY RADEON Xpress 200 Series

0x000003F6-0x000003F6 Primary IDE Channel

0x0000040B-0x0000040B System board resources

0x000004D0-0x000004D1 System board resources

0x000004D6-0x000004D6 System board resources

0x00000530-0x00000537 System board resources

0x00000870-0x0000087F System board resources

0x00000A79-0x00000A79 ISAPNP Read Data Port

0x00000C00-0x00000C01 System board resources

0x00000C14-0x00000C14 System board resources

0x00000C50-0x00000C52 System board resources

0x00000C6C-0x00000C6C System board resources

Table 6-9

System I/O Addresses (Continued)
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Specifications
I/O Address (hex) System Function (shipping configuration)

0x00000C6F-0x00000C6F System board resources

0x00000CD4-0x00000CD5 System board resources

0x00000CD6-0x00000CD7 System board resources

0x00000CD8-0x00000CDF System board resources

0x00000D00-0x0000FFFF PCI bus

0x00000F40-0x00000F47 System board resources

0x00001080-0x00001080 System board resources

0x00008000-0x0000805F System board resources

0x00008100-0x000081FF System board resources

0x00008400-0x0000840F ATI SMBus

0x00008410-0x0000841F Standard Dual Channel PCI IDE Controller

0x00009000-0x00009FFF PCI standard PCI-to-PCI bridge

0x00009000-0x00009FFF ATI MOBILITY RADEON Xpress 200 Series

0x0000A000-0x0000A0FF Realtek RTL8139/810x Family Fast Ethernet 
NIC

0x0000F000-0x0000FFFF PCI standard PCI-to-PCI bridge

0x0000FD00-0x0000FDFF Texas Instruments PCIxx21/x515 Cardbus 
Controller

0x0000FE00-0x0000FEFF Texas Instruments PCIxx21/x515 Cardbus 
Controller

Table 6-9

System I/O Addresses (Continued)
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Specifications
Table 6-10

System Memory Map

Memory Map Address (hex) System Function (shipping configuration)

0xD4100000-0xD41FFFFF PCI standard PCI-to-PCI bridge

0xD4100000-0xD41FFFFF ATI MOBILITY RADEON Xpress 200 Series

0xD8000000-0xDBFFFFFF PCI standard PCI-to-PCI bridge

0xD8000000-0xDBFFFFFF ATI MOBILITY RADEON Xpress 200 Series

0xFAC00000-0xFEBFFFFF PCI standard PCI-to-PCI bridge

0xF6C00000-0xFABFFFFF PCI standard PCI-to-PCI bridge

0xD4000000-0xD4000FFF Standard OpenHCD USB Host Controller

0xD4001000-0xD4001FFF Standard OpenHCD USB Host Controller

0xD4002000-0xD4002FFF Standard Enhanced PCI to USB Host 
Controller

0xD4003000-0xD40033FF ATI SMBus

0xFFF80000-0xFFFFFFFF System board

0xE0000000-0xE03FFFFF System board

0xE0000000-0xE03FFFFF System board resources

0x0000-0x0FFF System board
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Specifications
Memory Map Address (hex) System Function (shipping configuration)

0xD4208000-0xD42087FF Texas Instruments OHCI Compliant IEEE 
1394 Host Controller

0xD4200000-0xD4203FFF Texas Instruments OHCI Compliant IEEE 
1394 Host Controller

0xD4204000-0xD4205FFF Broadcom 802.11b/g WLAN

0xFFEFF000-0xFFEFFFFF Texas Instruments PCIxx21/x515 Cardbus 
Controller

0xFFEFE000-0xFFEFEFFF Texas Instruments PCIxx21/x515 Cardbus 
Controller

0xF2C00000-0xF6BFFFFF Texas Instruments PCIxx21/x515 Cardbus 
Controller

0xD4206000-0xD4207FFF Texas Instruments PCIxx21 Integrated 
FlashMedia Controller

0xD4209000-0xD42090FF SDA Standard Compliant SD Host Controller

0xD4208C00-0xD4208CFF SDA Standard Compliant SD Host Controller

0xD4208800-0xD42088FF SDA Standard Compliant SD Host Controller

Table 6-10

System Memory Map (Continued)
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Specifications
Memory Map Address (hex) System Function (shipping configuration)

0xD4209400-0xD42094FF Realtek RTL8139/810x Family Fast Ethernet 
NIC

0xD4003400-0xD40034FF Conexant AC-Link Audio

0xD4003800-0xD40038FF SoftV90 Data Fax Modem with SmartCP

0xFEC00000-0xFEC00FFF System board resources

0xFEE00000-0xFEE00FFF System board resources

0xA0000-0xBFFFF PCI bus

0xA0000-0xBFFFF PCI standard PCI-to-PCI bridge

0xA0000-0xBFFFF ATI MOBILITY RADEON Xpress 200 Series

0xD6000-0xD7FFF PCI bus

0xDC000-0xDDFFF PCI bus

0xDD000-0xDDFFF Texas Instruments PCIxx21/x515 Cardbus 
Controller

0xE0000-0xFFFFF System board

0x40000000-0xFFFFFFFF PCI bus

Table 6-10

System Memory Map (Continued)
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A
Screw Listing

This appendix provides specification and reference information 
for the screws used in the computer. All screws listed in this 
appendix are available in the Screw Kit, spare part number 
412386-001, and the Display Screw Kit, spare part number 
417713-001.
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Screw Listing
Black Phillips PM2.0×5.0 Screw Locations

Table A-1

Black Phillips PM2.0×5.0 Screw

Color Qty. Length Thread
Head 
Width

Black 5 5.0 mm 2.0 mm 4.0 mm

Where used:
1 Two screws that secure the hard drive cover to the computer (screws are 
captured on the cover by C clips; documented in Section 5.3)
2 Two screws that secure the memory module compartment cover to the 
computer (screws are captured on the cover by C clips; documented in
Section 5.6)
3 One screw that secures the Mini Card compartment cover to the computer 
(screw is captured on the cover by a C clip; documented in Section 5.7)

mm
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Screw Listing
Phillips PM2.5×4.0 Screw Locations

Table A-2

Phillips PM2.5×4.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 4 4.0 mm 2.5 mm 4.0 mm

Where used:
4 screws that secure the hard drive frame to the hard drive (documented in 
Section 5.3)

mm
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Screw Listing
Phillips PM2.0×8.5 Screw Location

Table A-3

Phillips PM2.0×8.5 Screw

Color Qty. Length Thread
Head 
Width

Black 17 8.5 mm 2.0 mm 4.0 mm

Where used:
One screw that secures the optical drive to the computer (documented in
Section 5.8)

mm
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Screw Listing
Phillips PM2.0×8.5 Screw Locations

Table A-3

Phillips PM2.0×8.5 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 17 8.5 mm 2.0 mm 4.0 mm

Where used:
2 screws that secure the base enclosure to the top cover (documented in 
Section 5.12)

mm
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Screw Listing
Phillips PM2.0×8.5 Screw Locations

Table A-3

Phillips PM2.0×8.5 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 17 8.5 mm 2.0 mm 4.0 mm

Where used:
14 screws that secure the base enclosure to the computer (documented in 
Section 5.12)

mm
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Screw Listing
Silver Phillips PM2.0×5.0 Screw Locations

Table A-4

Silver Phillips PM2.0×5.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 20 5.0 mm 2.0 mm 4.0 mm

Where used:
3 screws that secure the switch cover to the computer (documented in
Section 5.9)

mm
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Screw Listing
Silver Phillips PM2.0×5.0 Screw Locations

Table A-4

Silver Phillips PM2.0×5.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 20 5.0 mm 2.0 mm 4.0 mm

Where used:
2 screws that secure the keyboard to the computer (documented in
Section 5.10)

mm
A–8 Maintenance and Service Guide



Screw Listing
Silver Phillips PM2.0×5.0 Screw Locations

Table A-4

Silver Phillips PM2.0×5.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 20 5.0 mm 2.0 mm 4.0 mm

Where used:
2 screws that secure the display panel to the display assembly (documented in 
Section 5.11)

mm
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Screw Listing
Silver Phillips PM2.0×5.0 Screw Locations

Table A-4

Silver Phillips PM2.0×5.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 20 5.0 mm 2.0 mm 4.0 mm

Where used:
4 screws that secure the base enclosure to the computer (documented in 
Section 5.12)

mm
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Screw Listing
Silver Phillips PM2.0×5.0 Screw Locations

Table A-4

Silver Phillips PM2.0×5.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 20 5.0 mm 2.0 mm 4.0 mm

Where used:
2 screws that secure the USB/S-Video board to the computer (documented in 
Section 5.13)

mm
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Screw Listing
Silver Phillips PM2.0×5.0 Screw Locations

Table A-4

Silver Phillips PM2.0×5.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 20 5.0 mm 2.0 mm 4.0 mm

Where used:
4 screws that secure the fan/heat sink assembly to the computer (documented 
in Section 5.18)

mm
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Screw Listing
Silver Phillips PM2.0×5.0 Screw Locations

Table A-4

Silver Phillips PM2.0×5.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 20 5.0 mm 2.0 mm 4.0 mm

Where used:
3 screws that secure the system board to the computer (documented in
Section 5.20)

mm
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Screw Listing
Phillips PM2.0×3.0 Screw Locations

Table A-5

Phillips PM2.0×3.0 Screw

Color Qty. Length Thread
Head 
Width

Black 15 3.0 mm 2.0 mm 4.0 mm

Where used:
2 screws that secure the optical drive bracket to the optical drive (documented in 
Section 5.8)

mm
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Screw Listing
Phillips PM2.0×3.0 Screw Location

Table A-5

Phillips PM2.0×3.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 15 3.0 mm 2.0 mm 4.0 mm

Where used:
One screw that secures the display inverter to the display assembly 
(documented in Section 5.11)

mm
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Screw Listing
Phillips PM2.0×3.0 Screw Locations

Table A-5

Phillips PM2.0×3.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 15 3.0 mm 2.0 mm 4.0 mm

Where used:
4 screws that secure the display hinges to the display assembly (documented in 
Section 5.11)

mm
A–16 Maintenance and Service Guide



Screw Listing
Phillips PM2.0×3.0 Screw Locations

Table A-5

Phillips PM2.0×3.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 15 3.0 mm 2.0 mm 4.0 mm

Where used:
4 screws that secure the wireless antenna transceivers to the display enclosure 
(documented in Section 5.11)

mm
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Screw Listing
Phillips PM2.0×3.0 Screw Locations

Table A-5

Phillips PM2.0×3.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Black 15 3.0 mm 2.0 mm 4.0 mm

Where used:
4 screws that secure the menu control button board to the top cover 
(documented in Section 5.17)

mm
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Screw Listing
Phillips PM2.0×7.0 Screw Locations

Table A-6

Phillips PM2.0×7.0 Screw

Color Qty. Length Thread
Head 
Width

Black 4 7.0 mm 2.0 mm 4.0 mm

Where used:
4 screws that secure the display assembly to the computer (documented in 
Section 5.11)

mm
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Screw Listing
Phillips PM1.5×3.5 Screw Locations

Table A-7

Phillips PM1.5×3.5 Screw

Color Qty. Length Thread
Head 
Width

Silver 2 3.5 mm 1.5 mm 3.0 mm

Where used:
2 screws that secure the Bluetooth module to the USB/S-Video board 
(documented in Section 5.14)

mm
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Screw Listing
Phillips PM1.5×2.0 Screw Locations

Table A-8

Phillips PM1.5×2.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 3 2.0 mm 1.5 mm 6.0 mm

Where used:
3 screws that secure the LED board to the top cover (documented in
Section 5.21)

mm
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Screw Listing
Phillips PM2.5×6.0 Screw Locations

Table A-9

Phillips PM2.5×6.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 16 6.0 mm 2.5 mm 5.0 mm

Where used:
2 screws that secure the Mini Card module to the computer (documented in
Section 5.7)

mm
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Screw Listing
Phillips PM2.5×6.0 Screw Locations

Table A-9

Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 16 6.0 mm 2.5 mm 5.0 mm

Where used:
6 screws that secure the display bezel to the display assembly (documented in
Section 5.11)

mm
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Screw Listing
Phillips PM2.5×6.0 Screw Locations

Table A-9

Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 16 6.0 mm 2.5 mm 5.0 mm

Where used:
4 screws that secure the display release hooks to the display assembly 
(documented in Section 5.11)

mm
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Screw Listing
Phillips PM2.5×6.0 Screw Locations

Table A-9

Phillips PM2.5×6.0 Screw (Continued)

Color Qty. Length Thread
Head 
Width

Silver 16 6.0 mm 2.5 mm 5.0 mm

Where used:
4 screws that secure the display panel to the display assembly (documented in 
Section 5.11)

mm
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Screw Listing
Phillips PM2.0×2.0 Screw Locations

Table A-10

Phillips PM2.0×2.0 Screw

Color Qty. Length Thread
Head 
Width

Silver 2 2.0 mm 2.0 mm 4.0 mm

Where used:
2 screws that secure the ExpressCard assembly to the system board 
(documented in Section 5.22)

mm
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B
Software Update

and Recovery

Updating Software
Updated versions of the software provided with your computer 
may be available on the HP Web site.

Most software and BIOS updates on the HP Web site are 
packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, 
which contains information regarding installing and 
troubleshooting the file.

To update the software:

1. Identify your computer model, product category, and series or 
family. Prepare for a system BIOS update by identifying the 
BIOS version currently installed on the computer.

If your computer is connected to a network, consult the 
network administrator before installing any software updates, 
especially system BIOS updates.

✎ The computer system BIOS is stored on the system ROM. The 
BIOS initializes the operating system, determines how the 
computer will interact with the hardware devices, and provides 
for data transfer among hardware devices, including the time 
and date.

2. Access the updates by visiting the HP Web site at 
http://www.hp.com.

3. Install the updates.
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Software Update and Recovery
Updating the BIOS
To determine whether available BIOS updates contain later BIOS 
versions than those currently installed on the computer, you need 
to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System 
BIOS) can be displayed by pressing fn+esc (if you are already in 
Microsoft® Windows®) or by opening the Setup Utility.

To use the Setup Utility for displaying BIOS information:

1. Open the Setup Utility by turning on or restarting the 
computer, and then pressing f10 while the “Press <F10> to 
enter Setup” message is displayed in the lower-left corner of 
the screen.

2. If the Setup Utility does not open with the system 
information displayed, use the arrow keys to select the 
Main menu.

When the Main menu is selected, BIOS and other system 
information is displayed.

3. To exit the Setup Utility, use the arrow keys to select Exit > 
Exit Discarding Changes, and then press enter.

Ä
CAUTION: To prevent damage to the computer or an unsuccessful 
installation, download and install a BIOS update only when the computer 
is connected to reliable external power using the AC adapter. Do not 
download or install a BIOS update while the computer is running on 
battery power, docked in an optional docking device, or connected to an 
optional power source. During the download and installation, follow these 
instructions:
■ Do not disconnect power from the computer by unplugging the power 

cord from the AC outlet.

■ Do not shut down the computer or initiate standby or hibernation.

■ Do not insert, remove, connect, or disconnect any device, cable, 
or cord.
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To download a BIOS update:

1. Access the page on the HP Web site that provides software 
for your computer:

Select Start > Help and Support, and then select the 
software and drivers update.

2. Follow the instructions on the screen to identify your 
computer and access the BIOS update you want to download.

3. At the download area:

a. Identify the BIOS update that is later than the BIOS 
version currently installed on your computer. Make a note 
of the date, name, or other identifier. You may need this 
information to locate the update later, after it has been 
downloaded to your hard drive.

b. Follow the instructions on the screen to download your 
selection to the hard drive.

Make a note of the path to the location on your hard drive 
where the BIOS update will be downloaded. You will need 
to access this path when you are ready to install the update.

✎ If you connect your computer to a network, consult the 
network administrator before installing any software updates, 
especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that 
are displayed on the screen after the download is complete. If no 
instructions are displayed, follow these steps:

1. Open Windows Explorer by selecting Start > All 
Programs > Accessories > Windows Explorer.

2. In the left pane of the Windows Explorer window:

a. Click My Computer and then your hard drive 
designation. The hard drive designation is typically Local 
Disk (C:).

b. Using the hard drive path you recorded earlier, open the 
folder on your hard drive that contains the update.
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3. Double-click the file that has an .exe extension (for example, 
filename.exe).

The BIOS installation begins.

4. Complete the installation by following the instructions on the 
screen.

✎ After a message on the screen reports a successful installation, 
you can delete the downloaded file from your hard drive.

Updating Software Programs and Drivers
To download and install software other than a BIOS update:

1. Access the page on the HP Web site that provides software 
for your computer:

Select Start > Help and Support, and then select the 
software and drivers update.

2. Follow the instructions on the screen to find the software you 
want to update.

3. At the download area, select the software you want to 
download and follow the instructions on the screen.

✎ Make a note of the path to the location on your hard drive 
where the software will be downloaded. You will need to 
access this path when you are ready to install the software.

4. When the download is complete, open Windows Explorer by 
selecting Start > All Programs > Accessories > Windows 
Explorer.

5. In the left pane of the Windows Explorer window:

a. Click My Computer and then your hard drive 
designation. The hard drive designation is typically Local 
Disk (C:).

b. Using the hard drive path you recorded earlier, open the 
folder on your hard drive that contains the update.
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6. Double-click the file that has an .exe extension (for example, 
filename.exe).

The installation begins.

7. Complete the installation by following the instructions on the 
screen.

✎ After a message on the screen reports a successful installation, 
you can delete the download package from your hard drive.

Recovering System Information
Tools provided by the operating system and PC Recovery 
software are designed to help you with the following tasks for 
safeguarding your information and restoring it in case of a system 
failure:

■ Back up your information regularly to protect your important 
system files.

■ Make a set of recovery discs (PC Recovery software feature). 
Recovery discs are used to start up (boot) your computer and 
restore the operating system and software programs to factory 
settings in case of system failure or instability.

■ Create system restore points (operating system feature). 
System restore points allow you to reverse undesirable 
changes to your computer by restoring the computer to an 
earlier state.

■ Recover a program or driver (PC Recovery software feature). 
This feature helps you reinstall a program or driver without 
performing a full system recovery.

■ Perform a full system recovery (PC Recovery software 
feature). With PC Recovery, you can recover your full factory 
image if you experience system failure or instability. PC 
Recovery works from a dedicated recovery partition on the 
hard drive or from recovery discs you create.
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Backing Up Your Information

When to Back Up
■ On a regularly scheduled basis.

✎ Set reminders to back up your information periodically.

■ Before the computer is repaired or restored.

■ Before you add or modify hardware or software.

Backup Suggestions
■ Create system restore points using Windows XP Professional 

System Restore feature.

■ Store personal files in the My Documents folder and back up 
these folders periodically.

■ Back up templates stored in their associated programs.

■ Save customized settings in a window, toolbar, or menu bar 
by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset your 
preferences.

To copy the screen and paste it into a Word document:

a. Display the screen.

b. Copy the screen:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. To paste the copied images into a document, open Word, 
and then select Edit > Paste.
B–6 Maintenance and Service Guide



Software Update and Recovery
Using System Restore Points
When you back up your system, you are creating a system restore 
point. A system restore point allows you to save and name a 
snapshot of your hard drive at a specific point in time. You can 
then recover back to that point if you want to reverse subsequent 
changes made to your system.

✎ Recovering to an earlier restore point does not affect data files 
saved or e-mails created since the last restore point.

You also can create additional restore points to provide increased 
protection for your system files and settings.

When to Create Restore Points
■ Before you add or extensively modify software or hardware.

■ Periodically, whenever the system is performing optimally.

✎ If you revert to a restore point and then change your mind, you 
can reverse the restoration.

Create a System Restore Point
1. Select Start > Help and Support, and then click System 

Restore.

The System Restore window opens.

2. Click Create a restore point, and then click Next.

3. Follow the on-screen instructions.
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Restore to a Previous Date and Time
To revert to a restore point (created at a previous date and time), 
when the computer was functioning optimally:

1. Select Start > Help and Support, and then click System 
Restore.

The System Restore window opens.

2. Click Restore my computer to an earlier time, and then 
click Next.

3. Follow the on-screen instructions.

Creating Recovery Discs
PC Recovery Disc Creator creates a set of recovery CDs or DVDs 
for the computer. Use recovery discs to restore the operating 
system and software programs to factory settings, in case of 
system failure or instability.

✎ Handle these discs carefully and keep them in a safe place. The 
software allows the creation of only one set of recovery discs.

Note the following guidelines before creating recovery discs:

■ You will need high quality CD-R, DVD-R, or DVD+R media 
(purchased separately).

✎ DVD±RW/R and double-layer DVD±RW are not compatible 
with the PC Recovery Disc Creator software.

■ The computer must be connected to AC power during this 
process.

■ Only one set of recovery discs can be created per computer.
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■ Number each disc before inserting it into the computer 
optical drive.

■ If necessary, you can exit the program before you have 
finished creating the recovery discs. The next time you open 
PC Recovery Disc Creator, you will be prompted to continue 
the disc creation process.

To create a set of recovery discs:

1. Select Start > All Programs > System Recovery > 
PC Recovery Disc Creator.

The PC Recovery Disc Creator tool opens.

2. Click Next.

✎ If you are operating the computer on battery power, you will be 
prompted to connect to AC power before you can go to the next 
step.

3. Select the type of disc you want to use and click Next.

✎ The software examines the image and displays the number of 
blank discs needed to create your recovery discs.

4. Insert the first disc and follow the on-screen instructions to 
complete the creation of the recovery discs.
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Reinstalling Software Programs and Drivers
If a program or driver preinstalled at the factory is accidentally 
erased or is damaged, the Application and Driver Recovery tool 
allows you to reinstall it.

✎ Software not provided with this computer must be reinstalled 
from the disc provided by the manufacturer or downloaded 
from the manufacturer's Web site.

✎ Before reinstalling the program, be sure it is fully uninstalled.

The Application and Driver Recovery tool replaces corrupted 
system files and reinstalls deleted system files within the 
program.

■ In most cases, if the program you are reinstalling is still on 
your computer, the reinstallation process does not affect your 
personal settings.

■ In all cases, if a program has been deleted from your 
computer, the reinstallation process reinstalls the program or 
utility to the factory image but cannot restore your personal 
settings.

Reinstalling Preinstalled Programs and 
Drivers

1. Remove the program or driver:

✎ In some cases, drivers are not listed in the Add or Remove 
Programs list. If the driver is not listed, it does not need to be 
removed.

a. Select Start > Control Panel > Add or Remove 
Programs.

b. Click the program or driver you want to remove, and then 
click Change/Remove.
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2. Select Start > All Programs > System Recovery > 
Application and Driver Recovery.

The Application and Driver Recovery tool opens.

3. Select Application Installation or Driver Installation, and 
then click Next.

4. Follow the on-screen instructions to complete the program or 
driver recovery.

5. Restart the computer if prompted.

Reinstalling Programs from Discs
1. Insert the disc into the optical drive.

2. When the installation wizard opens, follow the installation 
instructions on the screen.

3. Restart the computer if prompted.

Performing a Recovery
PC Recovery software allows you to repair or restore the system 
if you experience system failure or instability. PC Recovery 
works from recovery discs that you create or from a dedicated 
recovery partition on the hard drive.

✎ Microsoft Windows XP has its own built-in repair features, 
such as System Restore and driver roll-back capabilities. If you 
have not already tried these features, try them before using 
PC Recovery.

✎ PC Recovery only recovers software that was preinstalled at 
the factory. Software not provided with this computer must be 
reinstalled from the disc provided by the manufacturer or 
downloaded from the manufacturer's Web site.
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Recovering from the Recovery Discs
To restore the system from the recovery discs:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart 
the computer.

3. Follow the on-screen instructions.

Recovering from the Partition on the 
Hard Drive
You can perform a recovery from the partition on the hard drive 
from either the Start button or f11.

To restore the system from the partition:

1. Access the PC Recovery tool:

❏ To access PC Recovery from the Start button, select 
Start > All Programs > System Recovery > 
PC Recovery.

❏ To access PC Recovery from f11, restart the computer and 
press f11 while the “Press <F11> for recovery” message is 
displayed on the screen.

The PC Recovery tool opens.

2. Select PC Recovery and click Next.

The computer restarts and the PC Recovery tool opens.

3. Click OK.

4. Follow the on-screen instructions to complete the system 
recovery.

If you want to perform a destructive recovery:

✎ A destructive recovery formats the hard drive and restores the 
computer to its factory state. Select this option only as a last 
resort.
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a. Click Advanced Options on the System Recovery screen.

b. Select Destructive Recovery and follow the on-screen 
instructions.

Deleting the Recovery Partition on the 
Hard Drive

The PC Recovery Advanced Options menu provides the option of 
deleting the recovery partition, which will increase space on the 
hard drive. Delete the recovery partition only if you have already 
created recovery discs.

Ä
CAUTION: After you create the recovery discs, you can increase space 
on the hard drive by deleting the recovery partition. However, doing this 
is not recommended. If you delete this partition, you will lose any 
information that is on the partition, including the PC Recovery software. 
Thereafter, you must use the recovery discs to access PC Recovery 
software.

To delete the recovery partition:

1. If you have not already created recovery discs, create 
them now.

2. Select Start > All Programs > System Recovery > 
PC Recovery.

The PC Recovery tool opens.

3. Select PC Recovery and click Next.

The computer restarts and the PC Recovery tools opens.

4. Click OK.

5. At the System Recovery screen, click Advanced Options.

6. Select Delete Recovery Partition (not recommended) and 
follow the on-screen instructions.
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Updating Reinstalled Software
After you perform a system recovery, connect to the Internet to 
update all reinstalled software.

To access update links for the operating system and other 
software provided on your computer:

» Select Start > Help and Support.

To update optional software, follow the instructions provided by 
the software manufacturer. Some programs include an update 
feature you can access from a Help button or menu within the 
program.
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Display Component Recycling

Å
WARNING: The backlight contains mercury. Caution should be 
exercised when removing and handling the backlight to avoid 
damaging this component and causing exposure to the mercury.

Ä
CAUTION: The procedures in this appendix can result in damage to 
display components. The only components intended for recycling 
purposes are the liquid crystal display (LCD) panel and the backlight. 
Careful handling should be exercised when removing these 
components.

✎ Materials Disposal
This HP product contains mercury in the display assembly 
backlight and may require special handling at end-of-life.

Disposal of mercury may be regulated because of environmental 
considerations. For disposal or recycling information, contact 
your local authorities or visit the Electronic Industries Alliance 
(EIA) at http://www.eiae.org.
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This appendix provides disassembly instructions for the display 
assembly. The display assembly must be disassembled to gain 
access to the backlight 1 and the LCD panel 2.

✎ Disassembly procedures differ from one display assembly to 
another. The procedures provided in this appendix are general 
disassembly instructions. Specific details, such as screw sizes, 
quantities, and locations, and component shapes and sizes, can 
vary from one computer model to another.

Refer to Section 5.11, “Display Assembly,” for display assembly 
disassembly steps.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers 1 and screws 2 that secure the 
display bezel to the display assembly.

Removing the Display Bezel Screw Covers and Screws
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2. Lift up and out on the left and right inside edges 1 and the 
top and bottom inside edges 2 of the display bezel until 
the bezel disengages from the display assembly.

3. Remove the display bezel 3.

Removing the Display Bezel
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4. Disconnect all LCD panel cables 1 from the display inverter 
board and remove the inverter board 2.

Removing the Display Inverter Board
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5. Remove all screws 1 that secure the LCD panel to the 
display enclosure.

6. Remove the LCD panel 2 from the display enclosure.

Removing the LCD Panel
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7. Turn the LCD panel upside down.

8. Remove all screws that secure the LCD panel frame to the 
LCD panel.

Removing the LCD Panel Frame Screws
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9. Use a sharp-edged tool to cut the tape 1 that secures the 
side of the LCD panel to the LCD panel frame.

10. Remove the LCD panel frame 2 from the display panel.

Removing the LCD Panel Frame
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11. Remove the screws 1 that secure the backlight cover to the 
LCD panel.

12. Lift the top edge of the backlight cover 2 and swing it 
forward.

13. Remove the backlight cover.

Removing the Backlight Cover
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14. Turn the LCD panel right side up.

15. Remove the backlight cables 1 from the clip 2 in the 
LCD panel.

Releasing the Backlight Cables
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16. Turn the LCD panel upside down.

17. Remove the backlight frame from the LCD panel.

Removing the Backlight Frame
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Å
WARNING: The backlight contains mercury. Caution should be 
exercised when removing and handling the backlight to avoid 
damaging this component and causing exposure to the mercury.

18. Slide the backlight out of the backlight frame.

Removing the Backlight
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19. Disconnect the display cable 1 from the LCD panel.

20. Remove the screws 2 that secure the LCD panel to the LCD 
rear panel.

21. Release the LCD panel 3 from the LCD rear panel.

22. Release the tape 4 that secures the LCD panel to the LCD 
rear panel.

Releasing the LCD Panel
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23. Remove the LCD panel.

Removing the LCD Panel

24. Recycle the backlight and LCD panel.
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Connector Pin Assignments

Table D-1

Universal Serial Bus

Pin Signal Pin Signal

1 +5 VDC 3 Data +

2 Data – 4 Ground
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Connector Pin Assignments
Table D-2

RJ-45 (Network)

Pin Signal Pin Signal

1 Transmit + 5 Unused

2 Transmit – 6 Receive –

3 Receive + 7 Unused

4 Unused 8 Unused
D–2 Maintenance and Service Guide



Connector Pin Assignments
Table D-3

S-Video-Out

Pin Signal Pin Signal

1 TV-Ground 5 TV-CD

2 TV-CVBS 6 TV-Ground

3 TV-Ground 7 TV-YD

4 TV-Ground
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Table D-4

External Monitor

Pin Signal Pin Signal

1 Red analog 9 +5 VDC

2 Green analog 10 Ground

3 Blue analog 11 Monitor detect

4 Not connected 12 DDC 2B data

5 Ground 13 Horizontal sync

6 Ground analog 14 Vertical sync

7 Ground analog 15 DDC 2B clock

8 Ground analog
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Table D-5

RJ-11 (Modem)

Pin Signal Pin Signal

1 Unused 4 Unused

2 Tip 5 Unused

3 Ring 6 Unused
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Connector Pin Assignments
Table D-6

Audio-In (Microphone)

Pin Signal Pin Signal

1 Audio signal in 3 Ground

2 Audio signal in

Table D-7

Audio-Out (Headphone)

Pin Signal Pin Signal

1 Audio out, left channel 3 Ground

2 Audio out, right channel
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Power Cord Set Requirements

3-Conductor Power Cord Set
The wide range input feature of the computer permits it to operate 
from any line voltage from 100 to 120 or 220 to 240 volts AC.

The power cord set included with the computer meets the 
requirements for use in the country where the equipment 
is purchased.

Power cord sets for use in other countries must meet the 
requirements of the country where the computer is used.
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General Requirements
The requirements listed below are applicable to all countries.

■ The length of the power cord set must be at least 1.5 m 
(5.0 ft) and a maximum of 2.0 m (6.5 ft).

■ All power cord sets must be approved by an acceptable 
accredited agency responsible for evaluation in the 
country where the power cord set will be used.

■ The power cord sets must have a minimum current capacity 
of 10 amps and a nominal voltage rating of 125 or 250 V AC, 
as required by each country’s power system.

■ The appliance coupler must meet the mechanical 
configuration of an EN 60 320/IEC 320 Standard Sheet C13 
connector for mating with the appliance inlet on the back of 
the computer.
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Country-Specific Requirements

3-Conductor Power Cord Set Requirements

Country/Region Accredited Agency Applicable Note Number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

✎ NOTES:

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm² 

conductor size. Power cord set fittings (appliance coupler and wall plug) 
must bear the certification mark of the agency responsible for evaluation 
in the country where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 
3-conductor. The wall plug must be a two-pole grounding type with a 
NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark 
and registration number in accordance with the Japanese Dentori Law. The 
flexible cord must be Type VCT or VCTF, 3-conductor, 1.00 mm² conductor 
size. The wall plug must be a two-pole grounding type with a Japanese 
Industrial Standard C8303 (7 A, 125 V) configuration.
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Korea EK 4

The Netherlands KEMA 1

Norway NEMKO 1

People’s Republic 
of China

CCC 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

United Kingdom BSI 1

United States UL 2

✎ NOTES:

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 1.0 mm² 

conductor size. Power cord set fittings (appliance coupler and wall plug) 
must bear the certification mark of the agency responsible for evaluation 
in the country where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 
3-conductor. The wall plug must be a two-pole grounding type with a 
NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark 
and registration number in accordance with the Japanese Dentori Law. The 
flexible cord must be Type VCT or VCTF, 3-conductor, 1.00 mm² conductor 
size. The wall plug must be a two-pole grounding type with a Japanese 
Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75 mm² conductor size. 
Power cord set fittings (appliance coupler and wall plug) must bear 
the certification mark of the agency responsible for evaluation in the country 
where it will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75 mm² conductor 
size. Power cord set fittings (appliance coupler and wall plug) must bear the 
certification mark of the agency responsible for evaluation in the country 
where it will be used.

3-Conductor Power Cord Set Requirements (Continued)

Country/Region Accredited Agency Applicable Note Number
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A
AC adapter, spare part number 
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arrow keys 1–13
audio troubleshooting 2–21
audio-in (microphone) jack

location 1–7
pin assignments D–6

audio-out (headphone) jack
location 1–7
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B
Back button 1–19
base enclosure

removal 5–41
spare part numbers 3–9, 

3–29, 3–31, 5–41
battery

removal 5–5
spare part numbers 3–9, 

3–24
specifications 6–5

battery bay 1–20
battery light 1–7
battery release latch 1–20

Bluetooth module
removal 5–48
spare part number 3–9, 

3–30, 5–48
bottom components 1–20

C
cables, service considerations 

4–2
caps lock key 1–13
caps lock light 1–19
CMOS clearing 1–4
components
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front 1–6
keyboard 1–12
left-side 1–10
rear 1–10
right-side 1–8
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computer feet
illustrated 3–20
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overview 2–1
Security Menu 2–3

computer specifications 6–1
connector pin assignments

external monitor D–4
headphone D–6
microphone D–6
monitor D–4
RJ-11 (modem) D–5
RJ-45 (network) D–2
S-Video-out D–3
Universal Serial Bus (USB) 

D–1
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D
design overview 1–22
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disassembly sequence chart 
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display assembly
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specifications 6–3

display bezel
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5–33
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display hinge
removal 5–38
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spare part number 3–17, 

5–36
display panel
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troubleshooting 2–14
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removal 5–70
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illustrated 3–20
external monitor port
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pin assignments D–4

F
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removal 5–57
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drive 2–16, 2–17, 2–18
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2–24
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hard drive

OS loading problems 2–16
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3–19, 3–28, 5–6
specifications 6–4

hard drive bay 1–21
hard drive cover

illustrated 3–20
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headphone jack
location 1–7
pin assignments D–6

headset, spare part number 
3–21, 3–23

HP backpack, spare part 
number 3–24

HP Mobile Remote Control, 
spare part number 3–21, 
3–24

HP xc2000 Notebook 
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I/O address specifications 6–13
interrupt specifications 6–11

K
keyboard

removal 5–24
spare part numbers 3–5, 

3–28, 3–29, 5–24
troubleshooting 2–24

keyboard components 1–12
keypad keys 1–13

L
label area 1–21
LED board

removal 5–68
spare part number 3–5, 

3–30, 5–68
left-side components 1–10
Logo Kit, spare part number 

3–21, 3–30

M
mass storage devices, spare 

part numbers 3–18
Media button 1–15
memory module

removal 5–11
spare part numbers 3–15, 

3–27, 3–28, 5–11
memory module compartment 

1–21
memory module compartment 

cover
illustrated 3–20
removal 5–12

menu control button board
removal 5–54
spare part number 3–9, 

3–30, 5–54
microphone jack

location 1–7
pin assignments D–6

microphone, removal 5–40
Mini Card compartment 1–21
Mini Card compartment cover

illustrated 3–20
removal 5–16

Mini Card module
removal 5–14
spare part numbers 3–11, 

3–13, 3–24, 3–25, 5–14
modem jack

location 1–11
pin assignments D–5

modem module, 
troubleshooting 2–26
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monitor port
location 1–11
pin assignments D–4

mouse, spare part number 
3–21, 3–23

N
network jack

location 1–11
pin assignments D–2

network, troubleshooting 2–26
Next/Fast Forward button 

1–17
nonfunctioning device, 

troubleshooting 2–14, 2–23
num lock key 1–13
num lock light 1–19

O
OK button 1–19
optical drive

location 1–9, 1–20
OS loading problems 2–20
precautions 4–3
removal 5–18
spare part numbers 3–15, 

3–19, 5–18
specifications 6–8

P
packing precautions 4–5
password clearing 1–4
plastic parts 4–2
Plastics Kit

contents 3–20
spare part numbers 3–7, 

3–20, 3–30, 3–31

Play/Pause button, location 
1–15

pointing device, 
troubleshooting 2–25

power button 1–14
power button light 1–19
power connector 1–11
power cord

set requirements E–2
spare part numbers 3–22, 

3–23, 3–24
power light 1–7
power management features 

1–5
power, troubleshooting 2–8
Previous/Rewind button 1–15
processor

removal 5–59
spare part numbers 3–7, 

3–26, 3–31, 3–32, 5–59

R
rear components 1–10
removal

preliminaries 4–1
procedures 5–1

replacement
preliminaries 4–1
procedures 5–1

right-side components 1–8
RJ-11 (modem) jack

location 1–11
pin assignments D–5

RJ-45 (network) jack
location 1–11
pin assignments D–2
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RTC battery
removal 5–52
spare part number 3–9, 

3–30, 5–52
Rubber Feet Kit, spare part 

number 3–9, 3–30

S
screw kit

spare part numbers 3–21, 
3–30

screw listing A–1
SD Memory Card, spare part 

number 3–15, 3–24
security cable slot 1–11
serial number 3–1, 5–2
service considerations 4–2
speaker assembly

removal 5–50
spare part number 3–9, 

3–30, 5–50
speakers 1–7
specifications

battery 6–5
computer 6–1
display 6–3
DVD/CD-RW Combo 

Drive 6–6
DVD±RW/R and CD-RW 

Double-Layer Combo 
Drive 6–8

hard drive 6–4
I/O addresses 6–13
interrupts 6–11
optical drive 6–8
system DMA 6–10

static shielding materials 4–8
Stop button 1–17
S-Video-out jack

location 1–9
pin assignments D–3

switch cover
removal 5–21
spare part numbers 3–3, 

3–30, 3–31, 5–21
system board

removal 5–61
spare part numbers 3–7, 

3–9, 3–26, 3–31, 5–61
system DMA 6–10

T
tools required 4–1
top components 1–14, 1–16, 

1–18
top cover, spare part numbers 

3–5, 3–29, 3–31
TouchPad 1–19
TouchPad buttons 1–19
TouchPad light 1–19
TouchPad on/off button 1–19
TouchPad vertical scroll 

region 1–19
transporting precautions 4–5
troubleshooting

audio 2–21
Computer Setup 2–1
expansion product 2–14
flowcharts 2–6
keyboard 2–24
modem 2–26
network 2–26
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nonfunctioning device 
2–14, 2–23

OS loading 2–15
overview 2–1
pointing device 2–25
power 2–8
video 2–12

U
Universal Serial Bus (USB) 

connector
location 1–9, 1–11
pin assignments D–1

unknown password 1–4
USB camera cable, spare part 

number 3–16, 5–34
USB digital drive, spare part 

number 3–19, 3–23
USB travel mouse, spare part 

number 3–21, 3–23
USB/S-Video board

removal 5–46
spare part number 3–9, 

3–30, 5–46

V
video troubleshooting 2–12
volume buttons 1–17

W
Web camera board

removal 5–34
spare part number 3–16, 

5–34
Windows applications key 

1–13
Windows logo key 1–13

wireless button 1–17
wireless light 1–11, 1–19
workstation precautions 4–6
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